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 Safety Precautions
 (Be sure to read this before the training.)

Before designing a system, be sure to read this manual and pay close 
attention to safety.
During the training, pay attention to the following points to ensure 
correct handling.

  To prevent electric shock, do not touch the terminals while they are 
powered ON.

  Before removing safety covers, either turn the power supply OFF or 
confirm safety.

  Do not put your hand into moving parts.

[Precautions for Training]

  Proceed with the training under the guidance of a teacher.

  Do not remove the training machine module or change the wiring 
without permission. Doing so may result in malfunction, misoperation, 
injury or fire.

  Before attaching or detaching the module, turn the power OFF. 
Attaching or detaching the module while it is still ON may cause the 
module to malfunction or cause an electric shock.

  If unusual older is detected with the training machine (X/Y table, etc.) 
immediately turn the power switch to OFF.

  If an abnormality event occurs, immediately contact your teacher.

CAUTION

WARNING
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This text book introduces basic knowledge you should be aware of for 
sequence control together with simple examples for first-time users of 
PLCs.
Descriptions in this text book are primarily for the teaching material FX-I/O 
demonstration2 model that uses the micro PLC FX3G-14MR/ES type.

The following shows related materials:
■ FX3G Series main unit

FX3G Series Hardware Manual∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙JY997D33401
FX3G Series User's Manual［Hardware Edition］∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙JY997D31301

■ Programming
FX3S/FX3G/FX3GC/FX3U/FX3UC Series Programming Manual
［Basic & Applied Instruction Edition］∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙JY997D16601

■ Handy programming panel
FX-30P Installation Manual∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙JY997D34201
FX-30P Operation Manual∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙∙JY997D34401

INTRODUCTION

This document does not guarantee the implementation of industrial 
copyright and other rights, nor authorizes rights of implementation. 
Also, MITSUBISHI ELECTRIC CORPORATION cannot assume any 
responsibility whatsoever for problems in terms of industrial copyright 
that may arise by use of the content described in this document.

• Windows, Windows 7, Windows 8 are registered trademarks of Microsoft Corporation 
in the United States and other countries.

• All other company names and product names used in this document are trademarks 
or registered trademarks of their respective companies.

© 2006 MITSUBISHI ELECTRIC CORPORATION
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 Let's Learn About Sequences

Let's learn about sequence control
Sequence control is a word that we ordinarily do not hear often. Yet, it exists all  
around us and we have contact with it in our day today lives.
For example, a fully automatic washing machine is an excellent example of 
"sequence control."
In this chapter, we will consider what "sequence control" is and the affect it has 
on our daily lives.

WHAT IS "SEQUENCE CONTROL?"
Chapter 1
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1.1 What Is "Sequence Control?"
What does "sequence" mean?
Though the word "sequence control" may generally be unfamiliar to us, it is used 
very often around us, and everyone is likely to have seen or have had contact 
with something that is controlled by sequence control.

Dictionaries describe the word "sequence" as follows:

From this, we can understand that "sequence" refers to a succession or order in 
which events occur.

Examples of things you are familiar with
Let's consider an example of a car wash you frequently catch sight of at a gasoline stand.

(1) State or fact of being sequent or consequent

(2) Succession 

(3) Order of succession 

(4) A series of things following in order, etc. 

Put your m
oney in and press

the STAR
T button.

The car is first w
ashed w

ith
w

ater.

Dirt and m
ud is then rem

oved
from

 the car with detergent.

B
rushed w

ith a big rotating
brush.

A
nd then w

ashed again w
ith

w
ater.

W
ater is brushed off the car   

and the car w
ash is com

plete.

Sequence

START

STOP
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Though operation of the car wash on the previous page was described in 
approximate terms, this order is the basic way of thinking behind sequences, and 
making this sequence operate correctly and automatically countless times as 
intended becomes sequence control.

Sequence control is used extensively and is a vital approach in all situations and 
all fields.

Sequence control is used not just in complex applications but also in applications 
very familiar to us.

FA (factory automation) equipment in factories

Control of conveyors, various processing machines, 
various assembling machines and others

•  Large washing machine
•  Ticketing machine
•  Individually specified equipment such as cold storage 
  and freezing

•  Control of parking lots
•  Control of physical distribution conveyors
•  Control of floodgates
•  Control of vinyl greenhouses
•  Control of signals and electric spectaculars
•  Control of shutter doors and others

 Food manufacturing/processing equipment

 For control of various automationVarious equipment for professional use

0 0 0 0 0

0 0 0 0 0

0 0 0 0 0

0 0 0 0 0

0000Ticket

Control of various manufacturing machines for material 
treatment, forming, heating, cutting, packaging and others

Sequence control is used extensively in various fields.
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START

STOP

1.2 Devices Associated with Sequence Control
Component devices in sequence control
The following devices are used to perform sequence control.
These devices can be broadly classified as follows:
• "devices operated by personnel"
• "devices that notify personnel of machine states"
• "devices that detect machine states"
• "devices for making machines move"

Various devices are also combined to perform sequence 
control in a car wash, for example.

Devices operated by personnel Devices for notifying personnel of machine states

Devices for making machines move

Personnel

Switches, etc. Lamps, buzzers, etc.

Pumps for discharging
detergent or water, and 
motors, etc. for rotating 
brushes

Sequence

Devices operated by personnel Devices for detecting machine states

Start/stop buttons, etc.

Devices for notifying personnel of machine states

In-operation lamps, etc.

Switches, etc. for detecting arrival of vehicle
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The devices shown in this figure are just examples and only a few of many such 
devices.
In sequence control, combinations of devices such as these are made to operate 
in accordance with a work procedure.
Of these devices, "devices operated by personnel" and "devices for detecting 
machine states" become the conditions for making things move in sequence 
control, while "devices that notify personnel of machine states" and "devices for 
making machines move" are the devices that are operated in accordance with 
these conditions.

Operation panel ----- A panel on which "devices operated by personnel" 
(pushbutton switches, selector switches, etc.) and 
"devices for notifying personnel of machine states" 
(lamps, digital displays, etc.) are installed.

Control panel -------- A panel on which devices, such as electromagnetic 
contactors, relays and PLCs, for controlling machine 
movement, are installed.

Magnetic contactors, relays, etc.

Devices for detecting machine states Devices for making machines move
Machine

Limit switches, proximity switches, etc. Motors, solenoid valves, etc.

Though small-load devices such as 
small-size solenoid valves and pilot 
lamps can be driven directly by a PLC, 
large-load devices such as large-size 
solenoid valves must be driven via an 
electromagnetic contact or relays.

Control
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1.3 Items Required for Sequence Control
Let's actually consider sequence control.
Now, let's try actually considering sequence control based on the connection 
diagram below. The following also describes the terms you need to know in 
learning sequence control.

 Example 1  The electrical circuit below is wired using a pushbutton switch and       
                     lamps (blue, red).
    Content of sequence control
(1) When the pushbutton switch is not pressed, electricity flows along route B 
     and the blue lamp is lit.
(2) When the pushbutton switch is pressed, electricity flows along route A and     
     the red lamp lights.
(3) When the pushbutton switch is released, the blue lamp lights again as in (1) above.
     The operations in (1) through (3) are part of sequence control.

Connection diagram

Blue lamp

Red lamp

Relay

Pushbutton

Power supply

Power supply

A

B
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    About contacts
Contacts perform a switching operation to allow or block the flow of electricity. The 
two basic  contacts are N.O. contacts and N.C. contacts. Switches, relays, 
timers, counters and other devices have contacts

A "N.O. contact" is a "normally open" contact, and closes when the contact is 
actuated.

A "N.C. contact" is a "normally closed" contact, and opens when actuated.

Pushbutton

Pushbutton

Moving contact

Moving contactMoving contact

Moving contact

Press button

Press button

Fixed contact

Fixed contact

Fixed contact

Flow of
electricity

Flow of
electricity

Fixed contactWiring

Wiring WiringWiring

Circuit
closed Circuit

open

Wiring

Contact

Wiring Spring

Spring Spring

Before button is pressed (in return position) After button is pressed (in operating position)
Spring

Circuit
open

 Note 1   "Actuate" here means to force operation from normal state of rest. The operation of
              pressing a pushbutton corresponds to actuation.

N.O. contacts

N.C. contacts

Operation: In the case of a pushbutton switch
                   When the pushbutton switch is not pressed, the contact is open.
                   When it is pressed, the contact closes.

Operation: In the case of a pushbutton switch
                   When the pushbutton switch is not pressed, the contact is closed.
                   When it is pressed, the contact opens.

Let's learn some new terms.
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Relays
Relays incorporate an electromagnet. By action of the electromagnet, pulls a 
moveable contact to open or close the contact*.

Moving 
contact

Moving 
contact

Current flows in the contact.

Fixed contact Fixed contact

Flow of
electricity

Spring

When electricity flows in 
the electromagnet, the 
moving contact is actuated.

When electricity stops, the moving 
contact returns to the former 
position due to the spring.

 

Contact OFFContact ON

N.C. (normally closed) contacts

Moving 
contact

Moving contact
Current flows in the contact.

Fixed 
contact

Electromagnet Electromagnet

Electromagnet
Electromagnet

Current flows 
in the coil.

Spring

When electricity flows in 
the electromagnet, the 
moving contact is actuated.

When electricity stops, the moving 
contact returns to the former 
position due to the spring.

Contact OFF
Contact ON

N.O. (normally open) contacts

*Contacts : A contact refers to the contact area which executes the switching operation, and conducts or blocks electricity. Not 
only relays but also switches, timers, counters and other devices incorporate contacts. Contacts are mainly classified 
into N.O. (normally open) contacts and N.C. (normally closed) contacts (as described on the previous page).
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     Where are relays used?
(1) Relays can make large motors and lamps operate by using small signals.

(2) Relays can make motors and lamps in remote sites operate.

12 V DC(direct current)

100 V AC(Alternate current)
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Figure 1. Blue lamp

Product configuration

1.4 Performing Wiring Based on Sequences
Now that you've learned some new words
Let's train using Example 1 on page 8
that we studied for relay contacts.
    Outline of relay-wired training
    demonstration model

Power cable 1 pc
Pushbutton 1 pc
Blue lamp 1 pc
Red lamp 1 pc
Relay 1 pc
Wires (brown, red, orange, yellow,
            green, blue, purple, gray)         1 each 

Note) In this example, power supply terminals
          No.4 and No.5 are common terminals.

*1  What is an "actual wiring diagram?"

   Let's wire the training demonstration model.
1. Make sure that the training 
    demonstration model is turned OFF.
2. Wire the blue lamp in Figure 1 by 
    connecting the wires as follows:
    Purple wire to No.7 terminal
    Yellow wire to No.4 terminal
    Gray wire to No.8 terminal
3. Wire the red lamp in Figure 2 by 
    connecting the wires as follows:
    Green wire to No.5 terminal
    Blue wire to No.6 terminal
    Brown wire to No.1 terminal
    Red wire to No.2 terminal
    Orange wire to No.3 terminal

This refers to a diagram that is as 
close as possible to the real thing and 
that shows circuit connections and 
devices used for the circuit. As wiring 
and the structure of devices can be 
accurately seen in this diagram, it is 
handy when actually manufacturing 
devices or performing maintenance.

Red lamp
Blue lamp

Relay

Pushbutton

DC power supply

Common 
contact N.C. contact Relay

Coil

Pushbutton

Pushbutton switch
N.O. contact

100 V AC

Figure 2. Red lamp

Wiring diagram

Common 
contact N.C. contact Relay

Coil

Pushbutton

Pushbutton switch
N.O. contact

*1
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Now that you've learned some new terms and phrases
   Let's check operation
    Let swap the content of sequence control explanation on page 8 with the new  
    terms and phrases you've learned.
(1) When the power is turned ON, the N.C. contact and route B is made , and the 

blue lamp is turned on.
(2) When the pushbutton switch (N.O. contact) is pressed, the action of the relay 

causes the N.O. contact to close. Route A is made , and the red lamp is turned on.
(3) When the pushbutton switch is released, the blue lamp is turned on again as in (1) 

above.

What is a "flow chart?"
With sequence control, various devices are combined to comprise a circuit. To 
explain, the control of these devices can become quite difficult using based 
methods. Therefore a flow chart is a preferred method for explaining a control 
sequence.
A flow chart uses rectangular symbols and arrows to more simply express the 
overall order of related operations.

What is a "time chart?"
A time chart expresses changes in the operation sequence over time.
The devices to be controlled are drawn on the vertical axis, while changes over 
time are drawn on the horizontal axis. Dotted lines with arrow heads are used to 
show the relationship between respective devices and resulting operations.

Time charts sometimes express changes over time without the use of arrows.

You can also learn the content of sequence control from flow charts and time charts.

Power ON Pushbutton
switch pressed?

Blue lamp  Lit
Red lamp  Out

Pushbutton
switch not
pressed?

Blue lamp  Out
Red lamp  Lit

Sequence expressed as a flow chart

Sequence expressed as a time chart

NO

Pushbutton

Relay

Pressed

Operating

Lit

Lit Lit

Closed

Released

Blue lamp

Red lamp

Pushbutton

NO

YES

YES

Relay



14

An actual wiring diagram is a diagrammatic means of making the structure of devices
and wiring easy to understand. However, the operation sequence is harder to follow 
in actual wiring diagrams for complex electrical circuits.
Let's try swapping an actual wiring diagram with a sequence diagram to illustrate this point.

Sequence diagrams are connection diagrams intended to make the content of 
operation of many circuits easier to understand. Unified standards enable this 
diagrammatic method to be easily understood by third parties.

Note) With the FX-I/O demonstration2 
training machine, both relays and 
lamps are driven by a 24 V DC 
power supply. However, in 
general, relays are driven by a 
24 V DC power supply and 
lamps are driven by a 100 V AC 
power supply. This is shown in 
the figure below.

Actual wiring diagram and sequence diagram

Wiring Diagram

Sequence Diagram

DC power supply

Pushbutton switch Relay coil

RELAY (N.C. contact)
Blue

BLUE

RED
Red

RELAY (N.O. contact)

DC power supply

PB RELAY
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Let's consider another example

Transfer pump
Pump

Well

Tank

LS2 (N.C. contact)
Float switch turns OFF
when tank is full.

LS1 (N.O. contact)
Float switch turns ON
when tank is empty.

 Example 2  Controlling the level of water in a tank
    
     Details of sequence control
(1) When the operation switch is closed, the float switch limit switch 1 closes if 

the tank is empty, and the magnet switch MC is operated to drive the transfer 
pump motor.

     Relay MC is designed to hold its own state even if the water level is at the mid 
position.

(2) When the tank becomes full, float switch limit switch 2 opens, hold operation 
of the relay MC is canceled, and the transfer pump motor stops.

(3) When the water level reaches the empty level, the motor starts to operate 
automatically again.

M

MC
Magnetic contactor 

Start switch

ON

OFF
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Motor
power
supply

Control power supply

Start switch

The start switch
stays ON even
if it is released
(latched operation
type).

Motor

Motor is driven when 
the relay is engaged.

*Breaker

Start switch

Full FullWater level mid position

Operation

Water level mid position Empty
Water level
mid position

Float switch
LS2
Float switch
LS1
Magnet
switch

The sequence in this section is generally replaced by a sequence program on a PLC.

About self-hold circuits
A "self-hold circuit" refers to an operation circuit that bypasses signals 
arriving from an external relay or other device by means of the contact of 
the relay itself.
Self-hold circuits can also be said to have a memory function that allows 
them to operate continuously even if the circuit is cut by releasing a pressed 
pushbutton.
In this circuit, the contact of the relay (MC *2) for driving the motor is 
connected in parallel to float switch limit 1 (LS1). This provides an example of 
a "self-hold switch."

Though limit switch 2 (LS2) functions to cut the self-hold circuit to stop the 
transfer pump motor, when limit switch 2 (LS2) is used with a N.C. contact, the 
switch can also be turned OFF to stop transfer of water during a switch contact 
failure or wiring break.

   Sequence diagram

Operation of self-holding circuit (time chart)

*Breaker        This device breaks the 
circuit when there is too 
much current.

*1

*2

*3

N.O. contact The float switch turns ON
when the tank is empty.

Magnetic
switch

N.O. contact

The float switch
turns OFF when
the tank is full.

N.C. contact

Even when the float 
switch LS1 turns OFF, 
operation of the magnet 
switch continues due to 
the self-holding circuit.

MC

MC
M

MC

MC*2

LS2 *3
LS1

*1
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Contact Category

Product Category

N.O. Contact N.C. Contact
Drive Source

Horizontal format Vertical format Horizontal format Vertical format

Pushbutton
switch
(auto-
return type)

Manual

Pushbutton
switch
(latched
operation 
type)

ON

OFF
Manual

Thermal
relay
(OCR)

Heater

Operation

Switch
(general) Manual

Limit
switch
(mechanical
operation) Dog Cam

Auxiliary
switch relay
contact

Electromagnetic

coil

Magnetic
contactor

Timer
(ON delay)

Timer
(OFF delay)

1.5 Let's Remember Sequence Symbols
List of main sequence symbols

(JIS C 0617)
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Introducing You to PLCs

What is a "PLC?"
PLC stands for "programmable controller" and is sometimes known as a 
"sequence controller" or SC. These are defined as electronic devices that 
control various devices via I/O sections and have built-in memory for 
storing programmable instructions.

Actually…
So far, we have performed "sequence control" by physically wiring relays 
and timers. This chapter considers the use of a simple PLC program to 
control electronic devices.

WHAT IS A "PLC?"
Chapter 2
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2.1 What is a "PLC?"
What do PLCs do?

Personnel

Switches, etc. Lamps, buzzers, etc.

Motors, solenoid valves, etc.

Devices for notifying personnel
of machine states

Devices operated
by personnel

Sequence control
Devices for making
machines move

Machine

Devices for detecting
machine states

The devices that are operated by personnel or that detect machine states in 
sequence control are called "instruction signals" or "condition signals."
Devices that notify personnel of machine states or that move machines are 
called "loads."

PLCs are responsible for carrying out "sequence control." The diagram above 
illustrates the control of these devices. Where the condition signals and loads in 
the devices are connected to the PLC. 

Sensors, etc.



21

2.2 How PLCs Work
How does sequence control work?

PLCs are microcomputer-controlled devices for industry.

Devices connected to the input side of the PLC are called "input devices," while
devices connected to the output side of the PLC are called "output devices."
One device is connected to each terminal block.

One input device and one output device may merely be connected to a PLC in 
this way, and the connection for performing sequence control is performed 
electronically inside the PLC.

PLC internal connections are programmed using dedicated sequence language 
(instructions), and a combination of these instructions is called a "sequence 
program." Sequence control is performed in accordance with this program, so 
there is no need to wire externally.

Limit switch

Relay contact

Select 
switch

Pushbutton switch

PLC

Input Devices

Handy Programming
panelPC(Software for programming)

Power supply

O
utput interface

Input interface

Storage
section

Operation
section

Memory

Microcomputer

Contactor

 Lamp

Solenoid valve

 (Solenoid valve)

Output Devices

Power supply
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Actually consider a PLC as a group of relays and timers

The figure above shows how the input devices, output devices and the sequence program are configured.
The input devices is connected to the PLC's input relays, and the output device is controlled via contacts for external outputs.

Input relays

Output contacts

The input relays convert the signals from an external device to signals for the 
PLC. In the above figure, the input device is designed to operate merely by 
connecting across the input terminal and the COM terminal.
However it should be noted that PLCs have a limited number of contacts, even 
though, an infinite number of contacts is provided on the sequence program.

The PLC has a built-in power supply 
for the input relays. When the 
contact of the input device is 
conducting, current flows along the 
dotted line to drive the input relay. 

When the output relays on the 
sequence program are driven, the 
contacts for external output close.
Provide a power supply for driving 
the external device outside the PLC.

Regardless of whether the external input device is a N.O. contact or a N.C. 
contact, the contact on the PLC that closes when the COM and input terminals 
are conducting is an N.O. contact, and the contact that opens is a N.C. contact.

Output contacts are otherwise known as just outputs. These are coutrolled by 
the sequence program, and are necessary for driving an external load.
Devices having a different power supply (AC or DC) can be connected to the 
contacts for external output. 

Input relays operated
by external signals

Sequence program operated
by input relay contacts

Output of output
relay operation

External load
operated

Power
supply

PL

Contacts for
external outputs

Input relays

PLC

Operation

Operation

PB1

LS1

PB2

X001

Y000

X001

X005

M100

X007

K100

X003

Output relays

Timers

Auxiliary relays

COM

X000

X001

X002

X003

X004

X005

X006

X007

X001

X003

X005

M100

T0

Y100

Input device

COM

Input relay

PLC

Input terminal

COM

PLC
Output device

Power supplyContacts for external outputs

Output terminal

COM1

Y000

Y001

Y002

Y003

MC
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An I/O number is assigned to each terminal to make the I/O devices connected 
to the input terminals and output terminals correspond to the input relays and 
output relays of the sequence program.
Timers and counters held internally by the PLC are also assigned to devices 
numbers in addition to each terminal number.

Element numbers ---- Element numbers comprise a symbol that shows what the   
devices is and a number that categorizes individual devices.

Input relays act as the "point of contact" for 
receiving signals, for example, from an input 
switch outside of the PLC. X is used to identify 
their device number. PLCs have a built-in 
number of input relays corresponding to the 
number of inputs (number of terminals).

Input relays : X000~

Output relays act as the "point of contact" 
for driving loads outside the PLC. Y is 
used to identify their device numbers. 
PLCs have a built-in number of output 
relays corresponding to the number of 
outputs (number of terminals).

Output relays : Y000~

Timers are held internally by the PLC, 
and function to measure time. Timers 
have coils and contacts. When a 
preset time is reached, a contact 
closes.

Timers : T0~

Counters are held internally by the 
PLC and count numbers. When a 
preset number is reached, a contact 
closes.

Counters : C0~

Auxiliary relays are held internally by the 
PLC and are also called "internal relays."

The number of inputs relays, output relays, timers, counters, and other devices
varies according to the model of PLC.

Auxiliary relays : M0~

Reference

Decimal, Octal and Hexadecimal
As shown in the following table, octal and hexadecimal numbers are assigned as 
devices numbers in addition to decimal numbers.

Auxiliary timers, timers, countersInput relays, output relays

General-purpose Q/A Series 
Micro PLC FX Series Octal Decimal

Hexadecimal Decimal

"Decimal"

"Octal"

"Hexadecimal"

The decimal number system is used most often, and counts up numbers in 
units of ten in the format 0 to 9, 10 to 19, 20 to 29 and so forth.
The octal number system counts up numbers in units of eight in the format 
0 to 7, 10 to 17, 20 to 27 and so forth.
The hexadecimal number system counts up numbers in units of 16 in the 
format 0 to 9, 0A, 0B, 0C, 0D, 0E, 0F, 10 to 19, 1A, 1B, 1C, 1D, 1E, 1F and 
so forth.
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Expressions used in sequence diagrams and sequence programs
The sequence program on a PLC replaces the input device and output device connected 
to each of the external terminals with a circuit for performing sequence control. For details 
on instruction words, see Chapter 4.
The following explains how to replace a sequence diagram with a sequence program.
This example shows the tank water level control described on page 15 replaced with a 
sequence program.

The following describes the various differences when a relay sequence program 
is replaced with a sequence program.

SW
LS2 LS1

MC

MC

MC

MC

X000 X002 X001

Y000

Y000
SW LS2 LS1 

Sequence diagram Sequence program

(1) How N.O. contacts and N.C. contacts are expressed
Relay sequence diagram Sequence program
N.O. contact

(2) The power supply circuit is not expressed.
(3) The sequence program is assigned devices numbers explained in the previous

page.

(4) Limit switch 2 in the sequence diagram is a N.C. contact but becomes a N.O. 
contact in a sequence program.
This is because the role of limit switch 2 in the above sequence diagram is to 
break the self-hold circuit of the MC and stop the MC. So, we should consider 
that it is in a conducting state at all times on the circuit.
Next, remember the operation of the input relay on page 22. In operation of 
the N.O. contacts and N.C. contacts in the sequence program, N.O. contacts 
turn ON and N.C. contacts turn OFF when the input relay is electrically 
conducting due to a change in state of the contact on the external wiring. Due 
to this fact, a N.O. contact must be used on the sequence program to obtain 
the same operating state.
In this way, when a PLC is used, N.O. contacts and N.C. contacts can be 
used for each of the contacts on the sequence program.

Important

N.O. contact

N.C. contact N.C. contact
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Operation of N.O contact and N.C. contact in a PLC program
The following describes the operation of N.O contact and N.C. contact in a 
PLC program.

• When no current is flowing in the input devices, a N.O. contact appears 
as OFF in PLC program.  A N.C. contact appears as ON. 

• When current is flowing in the input devices, a N.O. contact appears as 
ON in PLC program.  A N.C. contact appears as OFF. 

A contact in the PLC program does not replace the physical switch. It 
represents the input coming into the PLC. Therefore, we use N.O. contact 
in the PLC program for the signal of LS2. 
For details, please refer to (1) and (2) below. 

Reference

[1]Reason for using limit switch 2 (X2) as an N.O. contact in the PLC program 
 (1) When limit switch 2 is used as N.C. contact in zsame way as the sequence diagram

 (2) When the limit switch 2 is used as an N.O. contact

●Program concept
N.O. contacts become conductive and N.C. contacts become nonconductive when a 
signal is input from the outside.

Empty

Empty

Full

N.C. contact

N.C. contact

N.C. 
contact

N.O. 
contact 

Not 
conducting

Conducting

Not 
conducting Conducting

N.C. contact

N.O. contact 

Start

Full

Start

Empty

Empty

The conducting state 
is transferred as the 
“ON” signal.

The pump 
remains OFF.

The pump 
turns ON.

Electricity does not flow 
when the contact turns ON.

Electricity flows when the 
contact turns ON.
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Empty

Full

Empty

Full

Start

Empty

Full

Start

Empty

Full

Start

Empty

Full

Start

The pump
 is OFF.

The pump
 is OFF.

The pump 
turns ON.

The pump 
turns ON.

The limit switch 1 turns ON, 
and the pump turns ON.

The limit switch 1 turns OFF, 
but the pump remains ON 
by the self-holding function.

The limit switch 2 turns ON, 
and the pump turns OFF.

[2] Flow of water level control in the tank

•  The pump is OFF while the water is in the mid level.

• When the water reaches the empty level

• While the pump is ON and water is supplied

• When the water reaches the full level 
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2.3 Wiring and Programs
2.3.1 What are PLC wiring and programs like?
The figure below shows the circuit on page 16.

I/O wiring must be handled in the 
conventional way using cutting pliers 
and a screwdriver.

The connections between input terminals and input relay coils and between 
output contacts of output relays and output terminals were already established at
the delivery from the factory.

Complicated internal wiring in a PLC 
(sequence program), can be handled 
easily by operating the pushbuttons 
(keys) on the programming panel.

SW

COM

X000

COM

Fuse

Y000 MC
X000 X002 X001

Y000

Y000

X001

X002

LS1

LS2

Output wiringSequence programIntput wiring

The wiring of a PLC wiring can be divided up into I/O wiring and internal wiring.
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2.4 Advantages of Using PLCs
2.4.1 Effective use of PLCs

1 Economical
In general, PLC is more inexpensive than conventional control box
where 10 or more relays are required.

2 Less manpower for design
Large amount of labor-saving can be achieved through simplified parts
layout drawings, sequence design and pre-start-up and test procedures.

3 Short turn-around time
The turn-around time can be significantly reduced through reduction in quantity
of procured parts, parallel procurement of the machinery and control box,
flexibility in specification change, simplified wiring work and so forth.4 Downsizing and standardization
Significantly reduced in size than relay boards and mass-production is
possible by reusing the program.

6 Improved maintainability
Maintenance can be done in an easy manner, since few parts with life
limitation are used and the PLC has a self diagnosis function.

5 Improved reliability
Troubles due to relays and timers can be reduced and the component
with PLC can be used without any concern once the initial set-up of the
PLC is completed.
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2.4.2 Comparison with relay control

A Short History of PLCs
The device "PLC" came into being in 1968 as a result of 
commissioned development by General Motors in the United States, 
and the general market for PLCs started in the United States in the 
following year. The first domestically produced PLC made its 
appearance in Japan in 1970, yet it took six years for the first 
general-purpose PLC to appear in 1976. MITSUBISHI ELECTRIC 
CORPORATION initiated the market for general-purpose PLCs in the 
year 1977, and has since made one-board PLC modules a familiar 
name on the market. Since then, it has developed the 
general-purpose PLC K series with integrated numeric value 
processing functions, which was followed by the micro PLC F series 
with built-in programmer. Today a variety of PLC products are 
available world wide that can suite an array of control applications.

1
2
3
4
5
6
7
8
9

PLC controlMethodItem Relay control

Functionality

Reliability

Versatility

Device expandability

Ease of maintenance

Range of functions

Device size

Design, production period

PLCs can be used for any kind of
control depending on the program.

Once made, devices cannot
be used for other applications.

Changeability of control
content

PLCs can be repaired merely 
by replacing modules.

PLCs can be freely expanded 
up to their full potential.

If additions and modifications 
are required they are difficult.

Analog and positioning control 
also can be performed in 
addition to sequence programs.

PLCs do not increase in size 
even in complex, advanced 
control applications.

Design is simple even for 
complex control, and it does not 
take time to manufacture PLCs.

Many drawings are required, 
and it takes time to arrange 
parts and test assemblies.

Relay control only is 
supported.

Complex control is possible
by using many relays.

Control can be programmed
however complex it is.

Only the program needs to 
be changed, and control can 
be freely changed.

No other option but to
change the wiring

Reliability is higher as the 
center of operations is made 
up entirely of semiconductors.

Though there is no problem in regular 
use, there are restrictions in faulty 
contacts and service life of parts.

Periodic inspection and 
limited service life parts must 
be replaced.

Generally, large

Reference
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 Let's use a personal computer to create programs!

Let's use a personal computer to create programs!
GX Works2 software provides an efficient and easy way to create and edit 
sequence programs for PLCs. Once the basic operations are mastered, 
programming often involves straightforward repetition. Beginning with the most 
necessary operations, let's learn how to program from the beginning.

Smoothly begin new projects and update them with ease…
It is easy to debug programs with GX Works2 and update them as necessary. 
The operation status of the PLC and program can be monitored with a personal 
computer, so if some parts are not working as planned, changes and updates 
can quickly made.

Make programs easier to read
There is a "comment input function" in GX Works2 to make sequence programs
easier to read.
Comments can improve the efficiency of creating and debugging ladder 
programs.

THE OPERATION OF GX Works2
Chapter 3
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3.1 Basic knowledge for operating GX Works2
3.1.1 Layout of the GX Works2 screen

1) Title bar
The name of the opened project and the window operation icons are displayed.

1) Title bar

4) Status bar

Changing the size of GX Works2 and closing it

Display of the project name and its path Minimizing GX Works2 Closing GX Works2

Maximizing and restoring GX Works2

2) Menu bar

6) Edit screen

3) Toolbar

5)Navigation window
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2) Menu bar

Drop down menu items are displayed when a menu is selected.

3) Toolbar*

* : The contents of the toolbar can be moved, added, and removed. Therefore, the layout 
and items displayed depend on saved environment .

Frequently used functions are displayed with icon buttons for quick execution.

A description of
the function is
displayed when
the mouse cursor
stops over each
button.

4) Status bar
    The status of the operation and keyboard settings are displayed.

Current input mode is displayed.

Scroll Lock status

CPU
type

Caps Lock
status

The location of the
CPU connected

Num Lock
status
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6) Edit screen

5) Navigation window

The sequence program is 
displayed when [POU] → 
[Program] → [MAIN] is clicked.

The tree structure indicating the 
contents of “Project” is displayed 
in the above area when this 
button is clicked.

The personal computer connection 
destination (PLC connection) is 
displayed in the above area when 
this button is clicked.

Switch tab



35

3.1.2 Workspace and project

Project

Program

Device comment

Parameter

Device memory

Corresponds to a folder in Windows®.

Sequence program

Comments on devices

Parameter setting data of the PLC

Current device values or entered device values

Corresponds to a folder in Windows®.
Workspace

 zWorkspace
GX Works2 can control multiple projects under one name. 
Do not change the workspace configuration using Windows® Explorer or other software.

 zProject
The project consists of “Program”, “Device comment”, “Parameter” and “Device 
memory”. 
Altogether, this data is called “Project”, and saved in a folder having the workspace 
name.

When saved in workspace format
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3.2 Starting GX Works2 and creating a new project
3.2.1 Starting GX Works2

1) Start from the Start button of Windows®, 
and select the application as follows:

2) GX Works2 is started.

[GX Works2]

[MELSOFT Application]

[Programs]
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1) Select  from the toolbar, or select 
[Project] → [New] ( Ctrl + N )from the 
menu.

3.2.2 Creating a new project

2) Click the [▼] button of [Series].

3) Select "FXCPU".

4) Click the [▼] button of [Type].

5) Select "FX3G/3GC".

(Note) Select the series name that is actually 
used.

1) Click

2) Click

4) Click

3) Click and select

5) Click and select

1) Click



38

6) Click OK .

(Note) Choose "Simple Project" for the "Project 
Type". 
Do not check "Use Label". 
Select “Ladder” in “Language”.

7) A new project screen is displayed for 
project data to be input.

6) Click

7) New project screen
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3.3 Creating a program
3.3.1 Creating a program by using the function keys

[Program to be created]

X002
Y000

Y000

X000

X003
Y001

The keyboard shortcuts for ladder elements are displayed on the buttons of the toolbar.

POINT

F5 F6 F7

F8

F9

F5

Shift Shift

F6

Shift

F9

Ctrl

F10

F9

Ctrl
+

++++

POINT
In this book, the input and output
relay numbers are displayed with
three digits, such as "X000," and
"Y000." When using GX Works2,
however, "X0," "Y0," etc. may be
input.

Main key operations

  • "NO contact " and "Coil (    　　)(　) , (    　　)[　] " can be input directly without using the 
keyboard shortcuts.
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6) The ladder input is displayed.
7) Press the F7 (    　　)(　) key.

    Input "Y0".

8) Confirm by pressing the Enter  key or [OK].

9) The ladder input (     　　)(Y0) is displayed.

10) Press the Shift  + F5  key. 
  Input "Y0".

11) Confirm by pressing the Enter  key or 
[OK].

3) The ladder input
X2

is displayed.
4) Press the F6 key.

    Input "X0".

5) Confirm by pressing the Enter  key or [OK].

1) Press the F5  key. 
Input "X2".

Cancel it by ESC or [Exit].

2) Confirm by pressing the Enter  key or OK.

1) Input “X2”

4) Input “X0”

7) Input “Y0”

10) Input “Y0”

3) The ladder element is displayed.

6) The ladder element is displayed.

9) The ladder element is displayed.

2) Pressing the Enter  key

5) Pressing the Enter  key

8) Pressing the Enter  key

11) Pressing the Enter  key
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12) The ladder input
Y0

Y0 is displayed.
13) Move the cursor to the beginning of the 

next line.

14) Press the F5 key. 
Input "X3".

15) Confirm by pressing the Enter  key or 
[OK].

16) The ladder input
X3

is displayed.
17) Press the F7 (    　　)(　) key. 

Input "Y1".

18) Confirm by pressing the Enter  key or 
[OK].

19) The ladder input (     　　)(Y1) is displayed.

F4 (Build)

The gray shade disappears and the program is 
compiled.
If an error occurs, the cursor moves to the 
problematic part of the program. Correct the 
program.

20) Compile Operation [Important].

       Perform the "Compile" operation to 
finalize ladder that not been compiled 
(the gray part). 
 
Press the F4 (Build) key. 
Or select  from the toolbar, or select 
[Compile] → [Build] from the menu.

14) Input “X3”

17) Input “Y1”

12) The ladder element is displayed.

16) The ladder element is displayed.

13) Move the cursor

15) Pressing the Enter  key

18) Pressing the Enter  key

20) The gray shade disappears.

19) The ladder element is displayed.
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3.3.2 Creating a program by using the toolbar buttons

[Program to be created]

Click the toolbar buttons to input ladder elements.

POINT

X002
Y000

Y000

X000

X003
Y001

POINT
In this book, the input and output
relay numbers are displayed with
three digits, such as "X000," and
"Y000." When using GX Works2,
however, "X0," "Y0," etc. may be
input.

Main toolbar buttons
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6) The ladder input is displayed.

7) Click the toolbar button . 
Input "Y0".

8) Confirm by pressing the Enter  key or [OK].

 

9) The ladder input (     　　)(Y0) is displayed.

10) Click the toolbar button . 
Input "Y0".

11) Confirm by pressing the Enter  key or 
[OK].

Cancel it by ESC or [Exit].

3) The ladder input
X2

is displayed.

4) Press the toolbar button . 
Input "X0".

5) Confirm by pressing the Enter  key or 
[OK]. 

2) Confirm by pressing the Enter  key or [OK].

1) Click the toolbar button . 
Input "X2".

1) Input “X2”

4) Input “X0”

7) Input “Y0”

10) Input “Y0”

2) Click

5) Click

8) Click

11) Click

3) The ladder element is displayed.

6) The ladder element is displayed.

9) The ladder element is displayed.
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12) The ladder input
Y0

is displayed.
13) Move the cursor to the beginning of the 

next line.

14) Click the toolbar button . 
Input "X3".

15) Confirm by pressing the Enter  key or 
[OK].

16) The ladder input
X3

is displayed.

17) Click the toolbar button . 
Input "Y1".

18) Confirm by pressing the Enter  key or 
[OK].

19) The ladder input (     　　)(Y1) is displayed.

F4 (Build)

The gray shade disappears and the program is 
compiled.
If an error occurs, the cursor moves to the 
problematic part of the program. Correct the 
program.

20) Compile Operation [Important].

       Peform the "Compile" operation to 
finalize the ladder that has not been 
compiled (gray part). 
 
Press the F4 (Build) key. 
Or select  from the toolbar, or select 
[Compile] → [Build] from the menu.

17) Input “Y1”

14) Input “X3”

18) Click

15) Click

12) The ladder element is displayed.

16) The ladder element is displayed.

19) The ladder element is displayed.

20) The gray shade disappears.

13) Move the cursor
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3.4 Writing programs to the PLC
Write the created sequence program to the FX PLC.

3.4.1 Connecting PC to PLC 
Connecting the FX3G PLC (with a USB cable)
[Preparation on the personal computer side]
For connecting the FX3G PLC to the personal computer with a USB cable, it is necessary to 
install the USB driver software in the personal computer.
Install the USB driver software in accordance with the procedure described in the “GX Works2 
Operating Manual (Common)”.

PLC
built-in port
(USB)

USB cable

USB

GX Works2

USB Driver installation 
<When using Windows® 7, Windows® 8>
1. Connect the personal computer and the programmable controller CPU with a USB cable, and 

then turn on the programmable controller CPU.

2. From Windows® Control Panel, select [System and Security] - [Device Manager]. Right-click 
"Unknown device" and click "Update Driver Software".

3. The Update Driver Software screen is displayed. Select "Browse my computer for driver 
software" and specify "Easysocket\USBdrivers" in the folder where GX Works2 has been 
installed on the displayed screen. If multiple MELSOFT products are installed previously, refer 
to their installed location.

* The USB driver installation is different when using FX3U-USB-BD and FX-USB-AW. Installation method 
also differs depending on the personal computer, please refer to " GX Works2 operating manual (Common)" 
for details.

Point
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3.4.2 "Transfer Setup" in GX Works2  and "Writing programs"

Configure the settings of GX Works2 to communicate with the PLC.

3) Transfer Setup is displayed.

4) Double-click the icon  .

5) Set the communication port of the personal 
computer side.

• Choose "USB" for connecting to the built-
in USB port of the FX3G PLC. 

6) Click [OK] after the setting is completed.

7) Click [Connection test], to check 
communication with the PLC.

8) After checking, click [OK] to confirm the 
configured setting.

1) Click "Connection Destination".

2) Double-click "Connection1".

3) Transfer Setup is displayed.

4) Double-click

6) Click

5) Click

7) Click

8) Click

2) Double-click

1) click
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9) Set the "RUN/STOP" switch of the PLC to "STOP".
[Supplementary note: Automatic RUN/STOP 
function from the programming software]

• When attempting to write program while the 
PLC is in the RUN state, the message “The 
CPU status must be STOP to perform a write 
operation. Would you like to perform write 
operation?” appears after step (4).

• Click [Yes (Y)] to execute writing.

• When writing is finished, the message “The 
CPU status is currently STOP. Would you like to 
perform a remote-RUN?” appears.

• Click [Yes (Y)] to set the PLC to RUN state.

11) Click [Param + Prog].

12) Click [Execute]. 
(Refer to “Supplementary note” in 9 above also).

10) Select  from the toolbar, or select [Online] 
→[Write to PLC] from the menu.

13) Click [Close] after it is completed.

1) Set to 
    "STOP"

A dialog box showing the write progress is displayed.

10) Click

12) Click

13) Click

Write progress

11) Select the data
to be written
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3.4.3 Monitoring PLC operation

1) Set the "RUN/STOP" switch of the PLC to 
"RUN ".

 Check operation by monitor mode

2) Perform either of the following operations:

• Click the F3 (Monitor Mode) key.

• Click  on the toolbar.

• Select [Online] → [Monitor] → [Start 
Monitoring(All Windows)] from the menu.

1) Set to 
    "RUN"

1) Set [Switch X002 is "ON"] and [Switch X000 is "OFF"], and then check [Output Y000 is 
"ON"].

2) Check [Output Y000 is "ON"] while [Switch X002 is "OFF"].

3) Set [Switch X000 is "ON"] and then check [Output Y000 is "OFF"].

4) Check [Output Y001 is "ON/OFF"] in accordance with [Switch X003 is "ON/OFF"].

2) Click



49

1) The display of the monitor status dialog 

2) 4)3) 1)

 
 
 
 
 
 
 
 
 
 
 

2) Interpretation of the ladder monitor display

Reference

1) Scan time 
The maximum scan time of the sequence 
program is displayed.

2) PLC status 
The status of the PLC is displayed. 
"

▲
" is displayed when PLC is in RUN, 

and " ■" is displayed when PLC is in  
STOP. 

3) Monitor execution status. 
This icon is flashing during monitor mode.

4) Memory type 
The memory type of the PLC is displayed.

1. Contact Instruction
Input contact

Type
X0 : OFF X0 : ON

NO contact
X000

Contact open

X000

Contact close

NC contact
X000

Contact close

X000

Contact open

2.Out Instruction
Driving status

Type
Non-execution/

Non-drive
Execution/Drive

OUT instruction
Y000 Y000

SET instruction, etc.
SET M0 SET M0

The ON/OFF status of the device to be reset is displayed during monitor mode 
using the RST instruction.

Device status
Type

When device to be
reset is OFF

When device to be
reset is ON

RST instruction
RST M0 RST M0
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3.5 Editing a program
3.5.1 Correcting a program

Switch between "Ovrwrte" and "Insert"
  • Set to "Ovrwrte" when correcting and overwriting ladder.
  • New ladder will be inserted when the "Insert" mode is on.

Point

Switches between
"Ovrwrte" and "Insert"

by pressing the Insert key.
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[1] Changing the OUT coils and contacts

[Program to be corrected]

4) The corrected result is displayed and the 
ladder block is displayed in gray.

1) Double-click the part that needs to be 
corrected.

5) Confirm the changes by pressing the F4  
(Build) key.

2) Change "Y001" to "Y002".

3) Confirm by pressing the Enter  key or [OK].

5) F4 (Build)

X002

Y000

X000

X003
Y001

Y002
Change to

Y000

2) Change "Y002"

1) Double-click

4) The corrected result is displayed.

3) Pressing the Enter  key
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[2] Adding lines

[Program to be corrected]

3) The line reaching the dropped position is 
added.

4) Locate the cursor on the position where 
the OUT coil is to be added and click  on 
the toolbar.

1) Click  ( F10 ) on the toolbar.

X002

Y000

X000

X003
Y002

Add the vertical/
horizontal lines and
create the OUT coil.

Y000

Y003

2) Locate the cursor on the upper right of the 
desired vertical line to be added, and then 
drag it until it reaches the desired position, 
and then drop it.

5) Input "Y3".

6) Confirm by pressing the Enter  key or [OK].

1) Click

2) Drag

The line is added.

5) Change "Y3"

4) The position of the cursor

Locate the cursor on the upper right of the 
beginning of the vertical line to be added.

6) Pressing the Enter  key
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8) Confirm the changes by pressing the F4

(Build) key.

7) The added ladder is finished and the 
ladder block is displayed in gray.  

 8) F4 (Build)

•  Click  on the toolbar again to finish the 
operation.

Adding lines using keys
In GX Works2, lines can be added using the Ctrl  + , , ,  keys.

Reference

7) The added ladder
is completed.



54

[3] Deleting lines

[Program where lines are to be deleted]

3) The lines are deleted.

4) Delete the OUT coil by pressing the Delete

key.

1) Click  ( Alt + F9 ) on the toolbar.

X002

Y000

X000

X003
Y002

Delete this
ladder

Y000

Y003

2) Locate the cursor on the upper right of the 
desired vertical line to be deleted, and then 
drag it until it reaches the desired position, 
and then drop it.

3) Lines are deleted. 

1) Click

4) Delete it by the Delete key

Locate the cursor on the upper right of 
vertical line to be deleted.

2) Drag



55

5) The deleted ladder block is displayed in 
gray.

6) Confirm the changes by pressing the F4

(Build) key.

6) F4 (Build)

• Click  on the toolbar again to finish the 
operation.

Deleting lines using keys
In the GX Works2, lines can be deleted using the Ctrl  + , , , keys.

Reference
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3.5.2 Inserting and deleting rows

[1] Adding rows

[Program where a rung is to be inserted]

X002

Y000

X000

X003
Y002

Add this rungX001

Y000

Y001

1) Locate the cursor on the row below the one 
to be inserted.

A row is inserted above the row where the 
cursor is located

Select "Insert Row"

2) Right click the 
mouse

3) New row is inserted.

2) Right click the mouse at any place, and 
select [Edit] → [Insert Row].

3) A row is inserted.

4) Add ladder in the inserted row. 
X001

Y001
 

5) Confirm the changes by pressing the Build  
(F4) key.

4) Add ladder

1) Move the cursor to the row 
below the one to be inserted
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[2] Deleting rows

[Program where row is to be deleted]

3) The row is deleted.

1) Move to the row to be deleted.

2) Right click the mouse at any place, and 
select [Edit] → [Delete Row].

Confirm it by pressing Build  (F4).

Point

X002

Y000

X000

X003
Y002

Delete this row

X001

Y000

Y001

1) Move the cursor to 
the row to be deleted

2) Right click the 
mouse

3) Row is deleted.

Select "Delete Row"
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3.5.3 Cutting and copying (pasting) ladder

[1] Cut

[Program to be edited]

3) Select  from the toolbar or select [Edit] 
→ [Cut] ( Ctrl  + X  ) from the menu, and 
execute cut.

1) Move the cursor to the beginning of the 
ladder to be cut.

X002

Y000

X000

X001

Y000

Y001
Cut this row

2) Drag it until it reaches the desired position, 
and then drop it.

4) The selected area is cut 
A gray part remains when a smaller portion 
of the ladder is cut. After amending the 
ladder, confirm the changes by pressing 
the F4  (Build) key.

2) Drag the cursor until it reaches 
the desired position, and then 
drop it.

3) Execute cut

4) The selected
area is cut.

The cut and copy area
1) Move the cursor to the 

beginning of the cut 
area
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[2] Copy (pasting)

3) Select  from the toolbar or select [Edit] 
→ [Copy] ( Ctrl + C ) from the menu.

2) Drag the cursor until it reaches the desired 
position, and then drop it.

5) Select  from the toolbar or select [Edit] 
→ [Paste] ( Ctrl + V ) from the menu.

 
A gray part remains when a smaller portion 
of the ladder is pasted. After amending the 
ladder, confirm the changes by pressing 
the F4 (Build) key.

1) Move the cursor to the beginning of ladder 
to be copied.

4) Move the cursor to the position where to 
paste.

Using by the Insert  key
"Ovrwrte" mode : Pastes by overwriting
data from the cursor position.
"Insert" mode : Pastes it by inserting data at 
the cursor position.

Point

Y000

X000

X002
Y000

Copy this
row

X002
Y000

Y000

X000 Paste to
this row

[Ladder to be copied (pasting)]

2) Drag the cursor until it reaches the 
desired position, and then drop it.3) Execute copy

4) Move the cursor to the 
position where to paste

1) Move the cursor to the 
beginning of the copy area

5) Finish copy/paste
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3.6 Saving the program
3.6.1 Save and Save as

Point

1) Select  from the toolbar or select [Project] 
→ [Save] ( Ctrl + S  ) or [Save As] from the 
menu.

(When it is newly saved)

If there is ladder that has not been compiled, press Build  (F4).

(When it is saved by overwriting)

 Project saving is finished.   

2) Specify the storage destination for the file.

3) Specify the file name.

4) Specify the title describing the project 
(optional).

5) Click Save  .

6) Click Yes  in the confirmation dialog to finish.
6) Click

4) Specify the title 
(optional).

3) Specify the file name. 

2) Specify the storage 
destination for the file.

1) Click

5) Click
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3.6.2 Reading a project

1) Select  from the toolbar or select 
[Project] → [Open] ( Ctrl + O  ) from the 
menu.

If another project is open when reading/opening a new file, the current project is closed.
If there is uncompiled ladder in the project or the project is not saved, a warning message is
displayed.

Reference

2) Select the storage destination of the file.

3) Select the project to be read.

4) Click Open to read the project.

 

2) Select the storage 
destination of the file.

3) Select the project 
to be read.

1) Click

4) Click
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3.7 Necessary operation for debugging a program
For connecting to the PLC and writing a program to the PLC, see "3.4 Writing programs to the PLC".

3.7.1 Ladder monitor
Display the ladder, and monitor the conduction status of the contacts and the driving status 
of the coils.
(See section "3.4 Writing programs to the PLC") .

2) The ON/OFF status of the ladder and 
the current value of word devices (timer, 
counter and data register) are displayed in 
the ladder monitor window.

1) Select  from the toolbar or select 
[Online] → [Monitor] → [Start Monitoring(All 
Windows)] from the menu.

Reference 
 In GX Works2, stop monitoring by selecting the   icon (Stop Monitoring) on the toolbar or  [Online] 
→ [Monitor] → [Stop Monitoring] from the menu.
Ladder can be edited when monitoring is stopped.
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3.7.2 Device registration monitor
Specify one device or a range on the ladder monitor window, and register corresponding 
device(s) on the watch window.

5) The selected device(s) is (are) registered in 
the watch window.

6) It is possible to directly input device names 
such as “X0”, “M0” and “D0” to blank 
spaces of the “Device/Label” column 
instead of dragging & dropping device(s).

7) Select [Online] → [Monitor] → [Start 
Monitoring] from the menu.

1) Set the ladder monitor status.  (See “Ladder 
monitor” above).

4) When the mouse icon changes to , drag 
and drop to the watch window.

2)  • When registering one device, select it by  
 clicking it.

• When registering multiple devices, click 
and drag to select the corresponding 
range.

3)Display a watch window with 
[View]→[Docking Window]→[Watch 1]. 

2) When registering 
one device

2) When registering 
multiple devices

5) Device registration 
is completed.

4) Drag & drop the selected 
device(s) to the watch 
window.

7) When [Start Monitoring] is selected, 
the current values (Bit devices: 1 
(= ON) or 0 (= OFF), word devices: 
current value) are displayed.

Drag the mouse in this range.

6) Direct input

3) A Watch window 
is displayed.
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3.7.3 Device batch monitor
Specify a device and monitor a continuous range of devices that follow it.

1) Set to monitor mode. (See Section “3.7.1.  
Ladder monitor”).

3) Input the first device of the devices to be 
monitored in the "Device/Buffer Memory 
Batch" window and then pressing the Enter  
key to begin monitoring. 

(Note) When specifying a timer or counter, click 
[Reference], and specify the program “MAIN”.

4) The operation state is displayed in 
accordance with the device type.
• Bit devices (X, Y, M and S): 1 (= ON) or 0 (= OFF)
• Timers and counters: ON/OFF status, set 

value and current value of contact/coil
• Data registers: Current value

5) A bit device can be forcibly turned ON 
or OFF or the current value of a word 
device can be changed by selecting the 
corresponding displayed monitor data and 
clicking [Modify Value].

2) Select [Online] → [Monitor] → [Device/
Buffer Memory Batch] from the menu. Or 
right click the ladder window and select 
[Device/Buffer Memory Batch].

Note
3) Input the device

5) Modify Value
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3.7.4 Device test

[1] Force ON/OFF
Using the device test screen, forcibly turn ON/OFF the bit devices of the PLC (M, Y, T, C and 
so on). (The forced ON/OFF function for X is not available).
When the PLC is running, the forced ON/OFF function can turn on or off specific devices.

1) Set to monitor mode. (See Section “3.7.1.  
Ladder monitor”).

2) Select  [Debug] → [Modify Value] 
from the menu. 

Forced ON/OFF (Ladder monitor window)
Any bit device (contact and coil) can be forcibly turned on/off by double-clicking the device in the 
[Ladder monitor window] while pressing the [Shift] key.

Reference

3) Input the device number to be forcibly 
turned on/off.

4) • [ON]: Forces device to ON.

• [OFF]: Forces device to OFF.

• [Switch ON/OFF]: Forces the device to 
toggle ON/OFF each time it is pressed.

3) Input the device

4) Click
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[2] Changing the current value of a word device
Change the current value of the PLC’s word device (T, C, D and so on).

1)  Set to monitor mode. (See Section “3.7.1. 
Ladder monitor”) .

2)  Select [Debug] → [Modify Value] from the 
menu. 

3) Input the device number to be changed.

4) Input a new value.

5) Click [Set].

3) Input the device

4) New value 5) Click
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[3] Force ON/OFF and current value change using the watch window
It is possible to forcibly turn ON or OFF a bit device (such as M and Y) or change the current 
value of a word device (such as T, C and D) from the watch window.
When an input (X) is forcibly turned ON or OFF, it remains ON or OFF only in 1 scan cycle 
while the PLC is in the RUN state.
When checking the operation of outputs (Y), set the PLC to the STOP state.

1) Enter the device number to the “Device/
Label” column, and register it to the watch 
window.

(Note)After registering a device, select [Online] → 
[Watch] → [Start Watching] from the menu.

2) Enter a new value to the “Current Value” 
column, and pressing the Enter  key.

• Bit devices (such as X and Y): Enter “1” 
for “ON”, or “0” for “OFF”.

• Word devices (such as T, C and D): Enter 
a numeric value within the available 
range of the corresponding device.

2) Enter a new value.

1) Register a device.
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3.7.5 Writing a program to the PLC during RUN
Write the corrected part of the ladder to the PLC when the PLC is running.
Less time is needed for writing during RUN since the entire program is not transferred.

1) A contact will be added to the ladder on the 
left as an example. Within the ladder view, 
set the mode to write mode .

It is impossible to write the program to the PLC if the program in the PLC is different from the one 
in GX Works2. Verify in advance, or transfer the program first by using [Write to PLC].

Caution

2) Add a contact. 
The ladder block is displayed in gray.

3) Press [Shift] and [F4] together, or select 
[Compile] → [Online Program Change]   
from the menu.

5) The message "Online change has 
completed." is displayed. Click [OK].

Write during RUN [Shift]+[F4]

4) Click [Yes] to confirm the warning message 
about PLC safety regarding online 
changes.

2) Add a contact

4) Click

5) Click
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3.8 Inputting comments
3.8.1 Types of comments
The following 3 types of comments can be input.

Type Purpose
The number of 

characters
(full-width)

Remark

1) Device comment
A comment describing the role 
and function of each device

16
It is necessary to set the "Comments capacity" in 
the parameter setting when writing to the PLC. The 
"Comment range setting" must also be set.

2) Statement
A comment describing the role
and function of ladder blocks

32
This is a comment on GX Works2 side. 
(It is not downloaded to the PLC).

3) Note
A comment describing the role
and function of output 
instructions

16
This is a comment on GX Works2 side. 
(It is not downloaded to the PLC).

[Comment Examples]

Global device comment and local device comment in the GX Works2
• Global device comment: This type of comment can be written to PLCs.
• Local device comment: By setting local device comments, it is possible to create multiple 

comments different from global device comments. 
Local device comments can be written to Q Series PLCs, but cannot be written to the FX Series 
PLCs. In general, use “Global device comment”.

Point

How to display comments
Select [View] → [Comment] from the menu and then the comments are displayed.
Repeat the operation above to stop displaying comments.

Point

T5 NO contact exists at step10, 
whereas T5 NC contact exists 
at step8.

2) Statement

3) Note

1) Comment
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3.8.2 Operation for creating device comments

[1] How to input device comments using a list
1) Double click [Global Device comment] in 

the project list.

2) Input the start device of the devices to be 
commented in "Device Name", and press 
the Enter  key.

3) Input comments in the "Comment" column.

• When inputting comments for another 
device, input the device number again in 
step 2.

1) Click  from the toolbar and double-click 
the ladder element to be commented.

2) Input the comment in the "Enter symbol" 
window and click [OK].

• Click  on the toolbar again to finish the 
operation.

[2] How to input device comments in the ladder

1) Double-click

1) Double-Click

2) Input the device number

2) Input the comment

2) Input the device number

3) Input comments
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Setting for writing the device comments to the PLC
It is necessary to set "Parameter setting" and "Comment range setting" in order to write the device 
comments to the PLC.

1) Parameter setting

Point

1) Double click [Parameter] → [PLC 
parameter] in the project list.

2) Set the "number of blocks" in the 
"Comments capacity" setting. 
One block is equivalent to 50 
comments, occupying 500-steps 
of program memory.

How to input comments when creating a ladder
Reference

While inputting a ladder element, click the icon 
shown on the left to switch the input method.

2) Comment capacity setting

The capacity of the program 
decreases as more 
comment blocks are added.

 2) Check  3) Click

4) Comment 
range setting

2) Comment range setting

1) Choose [Online] →[Write to PLC] 
from the menu. 

2) Check "global device comment". 

3) Click [details]. 

4) Set the device type and range 
in the Device Comment Detail 
Setting dialog box.

1) Double-Click
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3.8.3 Operation for creating statements

1) Click  from the toolbar, and double-click 
anywhere on the ladder block where the 
statement is to be written.

2) Input the statement in the "Enter line 
statement" window and click [OK].

• Click  on the toolbar again to finish 
the operation.

3.8.4 Operation for creating notes

1) Click  from the toolbar, and double-click 
the output instruction symbol where the 
note is to be written.

2) Input the note in the "Enter Note" window 
and click [OK].

• Click  on the toolbar again to finish 
the operation.

1) Double-click

1) Double-click

2) Input the note

2) Input the statement



SEQUENCE INSTRUCTIONS

What you have learned up till now
So far we have explained that PLCs are a collection of many relays, timers and 
counters, and that their internal sequences can be wired by key operation on a 
programming panel. When performing this wiring work, rules matched to contact 
and coil connection methods and types of coils are required. These rules are the 
instructions.
Instructions are programmed in the format "instruction word + devices number" 
or by individual instruction words.
This chapter introduces several of the basic instructions for programming a PLC.

SEQUENCE INSTRUCTIONS
Chapter 4
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4.1 Let's Remember PLC Instructions
4.1.1 Commands and Programs
There are two types of peripheral devices (programming devices) for entering 
Sequence programs: devices for drawing sequence program on screen and 
devices for entering programs using instruction words (that is, devices for 
creating a list program). These devices differ only by program input method,
and the program itself is the same.

The following table summarizes the instructions held by a PLC, the meanings of 
each instruction and how the ladder is indicated in a sequence program.

     and     used in ladder 
indications indicate contacts. 
Contacts are in two states, 
conducting and 
non-conducting, depending 
on the ON/OFF state of input 
relays or output relays, 
auxiliary relays, timers, and 
counters.
          and    SET        show 
driving of coils.

Devices used for input 
using instruction words

Device used for input
using ladder diagrams

LD

LDI

AND

ANI

OR

ORI

ANB

ORB

OUT

SET

RST

NOP

END

Notation, Name

Load

Load inverse

AND

AND inverse

OR

OR inverse

AND block

OR block

Out

Set

Reset

No operation

END

Bus connection
instruction, 
N.O. contact

Bus connection
instruction, 
N.C. contact

Series connection,
N.O. contact

Series connection,
N.C. contact

Parallel connection, 
N.O. contact

Parallel connection, 
N.C. contact

Series connection
between blocks

Parallel connection
between blocks

Coil drive
instruction

Latch operation,
coil instruction

Cancel latch
operation, coil

instruction

No operation

End of program End of program Return to 0 step

For deleting program or space

Function Ladder representation

SET YMS

RST YMSTCD
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The internal sequence for the sequence controlling is created as the sequence program with the format
of circuit diagram (ladder diagram) and instruction list.

A program is comprised of multiple instruction codes and device numbers (operand).
These instructions are numbered in turn. This number is referred to as step number. (Step numbers are
automatically controlled).

Each "instruction" is comprised of "instruction code + device number". However, there are some
instructions without devices. Also in some cases, instruction codes are just referred to as instructions.

The max steps that can be programmed depend on the "program memory capacity" of the PLC that is used.
For example, there is a program memory with the capacity of "2000" steps in FX1S PLC, "8000" steps in
FX1N and FX2N, and "64000" steps in FX3U.

PLC repeatedly performs the instruction from step 0 to the END instruction. This operation is referred to as 
cyclic operation, and the time required to perform this one cycle is referred to as operation cycle (scan
time).
Operation cycle will be changed according to the contents of the programs and the actual operating orders,

rom several msec o several tens  of msec. 

The PLC program created by the format of    diagram (ladder diagram) is also stored in the program
memory of the PLC with the format of instruction list (program list).
The conversion between instruction list (program list) and    diagram (ladder diagram) can be done by
using the programming software in personal computer.

 

 

 

 

 

 Circuit diagram (ladder diagram)

Step
number

Instruction

Instruction
code

Device (number)
(operand)

0
1
2
3
4
5
6
9

LD
OR
ANI
OUT
LD
ANI
OUT
END

X001
Y000
X003
Y000
Y000
X006

T1  K30

Instruction list (program list)

R
ep

ea
t o

pe
ra

tio
n

f tranging

circuit

circuit

4.1.2 Program mechanics

X001
Y000

Y000

X003
0

4

END

X006
T1

K30

9

Y000
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OUT
END

List program

Circuit program

Output Y000 turns ON when input X000 is ON.
Output Y003 turns ON when input X003 is OFF.

The LD (Load) instruction is used for the 
first N.O. contact used on the bus, and the 
LDI (Load inverse) instruction is used for 
N.C. contacts. Contact instructions such 
as LD and LDI are used for devices such 
as input relays X, output relays Y, timers T, 
counters C, and auxiliary relays M.
Coil drive instructions such as OUT are 
used for devices other than input relays X.

By the above program...
Input  X000

Output  Y000

Output  Y003

0
Step Instruction

LD X000
OUT Y000
LDI X000
OUT Y003
END

1
2
3
4

LD
LDI

Bus connection 
instruction for N.O. 
contacts

Load

Bus connection 
instruction for N.C. 
contacts

Load inverse

Coil drive instruction
Out

Instruction used for 
the end of a program

End

Step numbers

Step numbers indicate the order and 
size of a program.
If you program instructions in the 
order of the list program, the PLC will 
automatically assign the step 
numbers.

4.1.3 N.O. contact, N.C. contact, OUR instruction, END instruction

X000

The rail is called a “bus”.

0

X000
2

4

Y000

Y003

END

Programming by instruction list 

ONOFF OFF

ONOFF OFF

ON OFF ON

Reference
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List program

Circuit program

Output Y000 turns ON when input X000 is ON, 
X001 is ON and X002 is OFF.
Output Y003 turns ON when input X000 is ON, 
X001 is ON, X002 is OFF, and X003 ON.

Y000 and Y003 operate when all 
contacts serially connected that 
are driving AND and ANI are 
conducting.

The AND (AND) instruction is used for N.O. 
contacts and the ANI (AND Inverse) instruction 
is used for N.C. contacts connected serially 
following the LD and LDI instructions.

Input  X000

By the above program...

Input  X002

Input  X001

Input  X003

Output  Y000

Output  Y003

0
Step Instruction

LD X000
AND X001
ANI X002
OUT Y000

X003AND
Y003OUT

END

1
2
3
4
5
6

AND
ANI

Series connection 
instruction for N.O. 
contacts

AND

Series connection 
instruction for N.C. 
contacts

AND inverse

Programming by instruction list 

X000
0

6 END

X001
Y000

Y003

X002

X003

ON

ON

ON

ONOFF

ON

ON

ON

4.1.4  Series connection

Reference
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OR
ORI

List program

The OR (OR) instruction is used for N.O. 
contacts and the ORI (OR Inverse) instruction is 
used for N.C. contacts connected in parallel 
following the LD and LDI instructions.
Output Y000 in the figure on the left operates 
when even one of the contacts connected in 
parallel that is driving OR and ORI is 
conducting.

By the above program...

0
Step Instruction

LD X000
OR X001
ORI X002
OUT Y000
END

1
2
3
4

Parallel connection 
instruction for N.O. 
contacts

OR

Parallel connection 
instruction for N.C. 
contacts

OR inverse

Circuit program

Programming by instruction list 

4.1.5  Parallel connection

X000
0

2

4 END

Y000

X001

X002

ON

ON

ON

ON OFF

ON

Input  X000

Input  X002

Input  X001

Output  Y000

Reference
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List program

Circuit program
Example program 1

Example program 1

Example program 2

When input X000 or X001, and X002 or 
X003 turn on simultaneously, Y000 
turns on. 

When the inputs X000 and X001 turn 
on simultaneously or X002 and X003 
turn on simultaneously, the output 
Y000 turns on. 

Refer to the appendix for the details of an 
ANB and an ORB command. 

By the above program... By the above program...

Input  X003

Input  X002

Input  X001

Input  X000

Output  Y000

Input  X003

Input  X002

Input  X001

Input  X000

Output  Y000

0
Step Instruction

LD X000
OR X001
LD X002
OR X003

Y000
ANB

1
2
3
4

OUT
END

5
6

4.1.6 Series and parallel connections

Programming by instruction list 

X000
0

END

Y000
X002

X001 X003

X000
0

END

Y000
X001

X002 X003

ON

ON

ON

ON

ONON

ON

ON

ON

ON

ONON

List program
Example program 2

0
Step Instruction

LD X000
AND X001
LD X002
AND X003

Y000
ORB

1
2
3
4

OUT
END

5
6

Reference
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SET
RST

Circuit program

Output Y000 turns ON when input 
X001 is turned ON.
After this, the operation state of Y000 
is held at ON even if the state of input 
X001 changes from ON to OFF.
Output Y000 turns OFF when input 
X003 is turned ON.

These instructions drive coils like the OUT 
instruction.
With the OUT instruction, coils programmed 
with the OUT instruction also turn OFF when 
the contact that drives the coil changes state 
from ON to OFF. However, when the SET 
(Set) instruction is used, the operation state 
of the coil is held at ON even if the state of 
the contact changes from ON to OFF.
The RST (Reset) instruction is used to 
change the state of the coil driven by the SET 
(Set) instruction from ON to OFF.

By the above program...

List program

0
Step Instruction

LD X001
SET Y000
LD X003
RST Y000
END

1
2
3
4

The SET/RST instructions are 
used for output relays Y and 
auxiliary relays M, for example.
The RST instruction is also used 
for counters and retentive timers.

Operation hold 
output instruction

Set

Operation hold 
cancel instruction

Reset

4.1.7. SET instruction, RST instruction

X001
0

X003
2

4 END

Y000RST

Y000SET

Programming by instruction list 

ON

ON

ON

Input method

Space

Space

Input X001

Input X003

Output Y000

Reference
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4.1.8 About Latch Circuits
Output operation can be held or cancelled by 
programming a self-hold sequence.

0
1
2
3
4

Step
LD
OR
ANI
OUT
END

X001
Y003
X003
Y003

Instruction
0
1
2
3
4

Step
LD
SET
LD
RST
END

X001
Y003
X003
Y003

Instruction

Y003 turns ON when X003 is ON 
and X004 is OFF.

Y003 continues to operate even if 
X003 is turned OFF. (This is 
"self-hold operation.") Y003 turns 
OFF when X004 is turned ON.

When the SET instruction is used, the output will stay ON even when the contact driving the coil turns OFF.
Also, it can be used multiple times for the same output without being treated as a double coil.  It useful for directly 
controlling an output from multiple points in the program.

By the above program...

Circuit program

[Output latch circuit]  [Output SET/RST circuit] 

[Output latch circuit]  [Output SET/RST circuit] 

Input  X001

Output  Y003

Input  X003

X001
0 Y003

Y003

X003

ON

ON

ON

X001
Y003

Y003

X003

END

X001

X003

END

Y003SET

Y003RST
same operation

0

4

0

4

2

Programming by instruction list 

Both circuits perform the same operation. 
Reference

Reference



82

4.2 About Timer Circuits

0
1
2

Timers Reference

Timer program

Of the various timers available, this section 
describes how to program a digital timer that 
is held internally on a micro PLC.

Step
LD
OUT
OUT

X000
Y000
T0 K100

Instruction
5
6
7

Step
LD
OUT
END

T0
Y003

Instruction

The timer contact operates after a preset 
delay has elapsed after the coil has been 
made conductive. (ON delay timer)
This preset time is called the "set value" 
and is expressed as K which can be set in 
the range 1 to 32,767.
For example, K100 is a timer of ten 
seconds*.
When X000 is turned OFF while the timer 
is being driven, the present value of the 
timer returns to "0" and the timer contact 
also turns OFF.
Input method

* : When a 100 ms (0.1 second) timer is used

By the above program...
Input  X000

Output  T0 (N.O. contact)

Output  Y000, T0 (coil)

Output  Y003 (coil)

X000
0

5

Y000

T0
(10 secs)

Y003

END7

K100

T0

ON

ON

ON

ON

10 secs

SECONDS

10

30

4020

50

600

STAR DELTA TIMER

Programming by instruction list 

Circuit program

Space

Reference
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4.3 About Counter Circuits

Counters

Counter program

Of the various counters available, this section 
describes how to program a general-purpose 
counter that is held internally on a micro PLC.

0
1
3
4

LD
RST
LD
OUT

X001
C0

C0
X003

7
8

LD
OUT

9

C0
Y003

Counters count the number of times a 
contact (X003) changes state from OFF to 
ON.
This contact (X003) is called the "count 
input," and the value counted by the counter 
is called the "present value."
The counter operates when the present 
value reaches the specified number (set 
value).
The set value can be set a value within the 
range 1 to 32,767.
After the counter has counted up, the 
present value of the counter does not 
change, and the output contact stays in an 
operating state.
When reset input X001 turns ON, the 
present value of the counter returns to "0" 
and the counter contact also turns OFF.
Input method

Output Y003

Present value of 
counter C0

Input X003 (count)

Input X001 
(reset)

ON

0
1

2
3

4
5

6
7

8
9 10

Reference

Step Instruction Step Instruction

Programming by instruction list 

TIME

By the above program...

X001
0

7

C0
K10

Y003

END9

C0RST

X003

C0

3

Reset input

Count input

K10
END

Space

Reference



84

A program like the one above is made using 16 program steps, (1) to (16).
The following shows the above program rewritten as a list program.

4.4 Order of Programs
Program order
Circuit diagrams are programmed from left to right and from top to bottom.

0
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15

LD
Step Instruction

OUT
LD
OR
AND
OUT
OUT
LD
AND
LD
AND
ORB
OUT
OUT
OUT
END

X000
Y000
X001
X002
X003
Y001
Y002
X004
X005
X006
X007

Y003
Y004
Y005

(1)

(3)

(4)

(5)

(2)

(6)

(7)

(13)

(14)

(15)

(16)

X000

X001

Y000

Y001

X002

X003

Y002

X004 X005
Y003

X006 X007

Y005

END

Y004

0
Step

2

7

15

(8) (9)

(10) (11) (12)

Programming by a command list 
Reference



Starting with simple programs

Enough for theory, and now for practice
In this chapter, you study all about handling and operation such as programming 
and monitoring based on some simple examples.

PROGRAM TRAINING
Chapter 5
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Escalator 
drive Y003

Pass detection switch: 1
      X003

Illumination 
lamp Y000

Passdetection switch: 0
            X001

5.1 Introductory Example 1 
      (Control of Escalators)

  I/O assignments
Input  Pass detection switch:0  X001
  Pass detection switch: 1  X003

Output Illumination lamp  Y000
  Escalator drive output  Y003

  Operation
(1)Let's assume that the escalator does not move until someone approaches it.
(2)When someone approaches the escalator and turns on pass detection switch: 

0, the illumination lamp lights and the escalator starts to move. (Escalator 
movement is up only).

(3) The person is carried up by the escalator, and when that person moves off 
the escalator, pass detection switch: 1 turns ON, and the illumination lamp 
and escalator return to a non-operating state.

In this example, consider both pass detection switches: 0 and 1 as non-hold type 
switches.
Another assumption in this example is that people do not continue to get on this 
escalator.

Let's consider a PLC program for an escalator.
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Escalator 
drive Y003

Pass detection switch: 1
      X003

Illumination 
lamp Y000

Passdetection switch: 0
            X001

5.1 Introductory Example 1 
      (Control of Escalators)

  I/O assignments
Input  Pass detection switch:0  X001
  Pass detection switch: 1  X003

Output Illumination lamp  Y000
  Escalator drive output  Y003

  Operation
(1)Let's assume that the escalator does not move until someone approaches it.
(2)When someone approaches the escalator and turns on pass detection switch: 

0, the illumination lamp lights and the escalator starts to move. (Escalator 
movement is up only).

(3) The person is carried up by the escalator, and when that person moves off 
the escalator, pass detection switch: 1 turns ON, and the illumination lamp 
and escalator return to a non-operating state.

In this example, consider both pass detection switches: 0 and 1 as non-hold type 
switches.
Another assumption in this example is that people do not continue to get on this 
escalator.

Let's consider a PLC program for an escalator.

The program is configured as follows
  Circuit program : Example 1

Circuit program : Example 2

  Let's check operation 
Enter the above program on the PLC, and check program operation.

When input X001 is turned ON, outputs Y000 and Y003 operate. Next, when 
input X003 is turned ON, outputs Y000 and Y003 become non-operational.

Pass detection 
switch: 0
      X001

Pass detection 
switch: 1

X003 Illumination lamp ON

Escalator drive

Self hold 
   Y000

Y000

Y003

END

Pass detection 
switch: 0
      X001

Pass detection 
switch: 1
      X003

Illumination lamp ON

Escalator drive

Illumination lamp OFF

Escalator stop

END

Y000SET

Y003SET

Y000RST

Y003RST

0

5

0

3

6

Refer to the appendix 2 for a list program.
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5.2 Introductory Example 2 (Control of Tea Dispenser)

Let's consider a PLC program for a tea dispenser

  I/O assignments 
Input Cup detection X000 (ON when cup is present)
 Dispense tea button X001
 Check tea leaves button X002
 Replenish water tank lower limit switch X003
 Replenish water tank upper limit switch X004

output Change tea leaves indicator lamp Y000
 Dispense tea output Y001
 Replenish water output Y003

  Explanation of operation
(1)When cup detection X000 is ON, and dispense tea button X001 is pressed 

(X001 turns ON), dispense tea output Y001 operates, and hot water is poured 
into the cup. Hot water is poured only for the duration that the button is 
pressed, and stops being poured when you release your hand from the 
button.
When cup detection X000 is OFF, hot water is not poured even by pressing 
dispense tea button X001.

(2)When water in the replenish water tank gets low, lower limit switch X003 turns 
ON and replenish water output Y003 operates.

    When replenish water output Y003 operates and water is poured into the tank, 
upper limit switch X004 finally turns ON, and replenish water output Y003 
becomes non-operational.

(3)When water is replenished five times, the change tea leaves indicator lamp 
lights.

(4)When the check button is pressed, the change tea leaves indicator lamp goes 
out.

Change tea leaves

Replenish water output

       Upper limit switch

       Lower limit switch

Y003

Y000

Dispense
Check

Check tea
leaves
X002

X003

Cup detection
X000

X004
Dispense tea

button
X001

Dispense tea
output

Y001

The program is configured as follows
  Circuit program

Let's check operation
Enter the above program on the PLC, and check program operation.

(1)Output Y001 operates when both inputs X000 or X001 turns ON.
(2)When input X003 turns ON, output Y003 operates, and when input X004 

turns ON, output Y003 becomes non-operational.
(3)Each time that output Y003 operates, the value of counter C0 is 

incremented by one. When C0 reaches "5", Y000 operates.
(4)When input X002 turns ON, the value of counter C0 returns to "0" and 

output Y000 becomes non-operational.

X000 X001

X003 X004

Y003

X002

Y000

RST C0

C0

Y001

END

C0

Y003
K5

Y003

Self hold

   Lower limit switch Upper limit switch

Dispense tea button
Dispense tea output

Replenish water output

Replenish water count

Change tea leaves indicator lamp

Counter reset

Cup detection

Replenish water output

Check button
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The program is configured as follows
  Circuit program

Let's check operation
Enter the above program on the PLC, and check program operation.

(1)Output Y001 operates when both inputs X000 or X001 turns ON.
(2)When input X003 turns ON, output Y003 operates, and when input X004 

turns ON, output Y003 becomes non-operational.
(3)Each time that output Y003 operates, the value of counter C0 is 

incremented by one. When C0 reaches "5", Y000 operates.
(4)When input X002 turns ON, the value of counter C0 returns to "0" and 

output Y000 becomes non-operational.

X000 X001

X003 X004

Y003

X002

Y000

RST C0

C0

Y001

END

C0

Y003
K5

Y003

Self hold

   Lower limit switch Upper limit switch

Dispense tea button
Dispense tea output

Replenish water output

Replenish water count

Change tea leaves indicator lamp

Counter reset

Cup detection

Replenish water output

Check button

Refer to Appendix 2 for the list program. 
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5.3 Introductory Example 3 (Control of Fan)

Let’s consider a PLC program for a Fan.

Operation 
(1) When the [Preparation] switch (X001) is turned ON, the [Ready indicator lamp] (Y000) 

turns ON and latched. When the [Preparation cancel] switch (X003) is turned ON, the 
[Ready indicator lamp] (Y000) turns OFF and unlatched. 

(2) When the [Fan start/stop] switch is pressed while the [Ready] indicator lamp (Y000) is ON, 
the electromagnetic contactor for the fan (Y002) is actuated and the fan starts or stops. 
The wind velocity of the fan can be selected by the selector switch (X005/X006).
• When X005 is ON: The weak wind output (Y001) is ON.
• When X006 is ON: The strong wind output (Y003) is ON.

I/O assignments 
Input

X000 [Fan start/stop] switch
X001 [Preparation] switch
X003 [Preparation cancel] switch
X005 [Weak wind] selection
X006 [Strong wind] selection

Output
Y000 [Ready indicator lamp]
Y001 Weak wind output
Y002 Electromagnetic contactor for fan
Y003 Strong wind output

Ready indicator lamp Weak wind Strong wind
Y000

Preparation
X001

Fan start/stop
X000

Preparation cancel
X003

X005 X006 Fan

Electromagnetic 
contactor for fan

Y002

Weak wind output
Y001

Strong wind output
Y003
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• Refer to the last page of this chapter for the solution.
• Refer to the appendix for the list program.

Circuit program 
Input required devices in blank areas, and complete the program.

Y000

Y002 Y003

Interlock

Y001

Y001

Y0000

4

16 END

Y002

Y003
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5.4 Introductory Example 4 (Control of Press Machine)

Let’s consider a PLC program for a press machine.

Operation
(1) When the conveyer switch [Start] (X001) is turned ON, the conveyer (Y003) turns ON 

and carries workpieces to the pressing position. 
When 4 workpieces are detected by the workpiece counting sensor (X004), the 
workpiece carrying conveyer (Y003) turns OFF and stops carrying workpieces.

(2) When the conveyer (Y003) stops, the press start buzzer (Y001) sounds. 
After 1 second, the press machine will perform pressing (Y002).

(3) The press machine completes press (Y002) in 2 seconds, the start buzzer (Y001) 
sounds, and the press machine stops pressing at the same time.

(4) After pressing is completed, the press workpiece count is reset, and operation is 
repeated from step (1).

I/O assignments
Input

X001 Conveyer switch
X004 Workpiece counting sensor

Output
Y001 Press start buzzer
Y002 Press output
Y003 Conveyer

Conveyer
Y003

Conveyer switch
X001

Workpiece counting sensor
X004

Press output Y002

Press start buzzer
Y001

Process flow

Run
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Circuit program
Input required devices in blank areas, and complete the program.

X004

X001 C0

Y003

0

4

8

21

18

END

C0
Y001

T0

Y002

T1

K10

K20

C0RST

• Refer to the last page of this chapter for the solution.
• Refer to the appendix for the list program.
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5.5 Introductory Example 5 (Timing Chart)
Let’s consider a PLC program for the timing chart below.

Operation
When the start switch (X001) is turned ON, the indicator lamp (Y000) turns ON and the timer 
(T0) starts measuring the time at the same time.
On condition that the timer (T0) reaches the set value 2 seconds later, the buzzer (Y001) 
turns ON and the timer (T1) starts measuring the time at the same time.
After that, the electromagnetic contactor (Y002), motor (Y003) and solenoid valve (Y004) 
turn ON at intervals of 2 seconds in the same way. After the last solenoid valve (Y004) 
remains ON for 2 seconds, all outputs turn OFF.

I/O assignments
Input

X001 Start switch
Output

Y000 Indicator lamp
Y001 Buzzer
Y002 Electromagnetic contactor 
Y003 Motor
Y004 Solenoid valve

Start switch

Interval: 2 sec.

Interval: 2 sec.

Interval: 2 sec.

Interval: 2 sec.

Interval: 2 sec.

Indicator lamp

Buzzer

Electromagnetic 
contactor

Motor

Solenoid valve

X001

Y000

Y001

Y002

Y003

Y004
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Circuit program  
Input required devices in blank areas, and complete the program.

T0

X001 T4
0

7

12

22

27

17

END

Y000

K20

T1

T2

T3

T0

•  Refer to the last page of this chapter for the solution.
•  Refer to the appendix for the list program.
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5.6 Introduction example answers 

Introductory 
Example 3

X001

Y000

X003

X000

X005

X006

Introductory 
Example 4

Y003

C0 K4

T0

T1

Introductory 
Example 5

Y000

Y001

T1 K20

Y002

T2 K20

Y003

T3 K20

Y004

T4 K20
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Let's use a personal computer to create the programs!

Appendix 1
THE OPERATION OF THE GX Developer
Using a personal computer, sequence becomes easier…   
If a personal computer software GX Developer is used to create and edit the sequence program, 
it becomes easier just like illustration making.
If the basic operations are mastered, it is just the repetition of them.
There are many functions easy to use in the software. Let’s master them sequentially starting 
from the necessary operations.

Smoothly starting up and adjusting…   
The program is accompanied by the debug.
The operation status of the PLC and program can be monitored on the personal computer 
screen, so if some parts are not working as planned, confirmation and adjustment can be 
conducted at once.

Make the program easy to read…   
There is a "comment input function" in GX Developer to make the sequence program easy 
to read.
It can improve the efficiency to create and debug the program if a comment is input.
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Appendix 1.1 Basic knowledge for operating GX Developer
Appendix 1.1.1 Construction of the GX Developer’s screen

1) Title bar 
The name of the opened project and the operation icon of windows are displayed.

    1) Title bar

   6) Status bar

  2) Menu bar

   3) Toolbar

5) Edit screen

    4) Project data list

Changing the size of GX Developer and quitting it Maximizing and restoring down GX Developer

Quitting GX DeveloperMinimizing GX DeveloperDisplay of the project 
name and its path

    1) Title bar

   6) Status bar

  2) Menu bar

   3) Toolbar

5) Edit screen

    4) Project data list
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2) Menu bar

Drop down menu will be displayed after menu is selected.

3) Toolbar

* :  The contents of the toolbar can be moved, added and removed, therefore the displayed items and 
the layouts depend on the various environments.

4) Project data list

Ladder creating window, parameter setting screen and so on are displayed by tree structure.

The description 
of the function 
will be displayed 
when the mouse 
cursor stops at 
the buttons.

Directly specify the items 
displayed by mouse clicking.

The frequently used functions are configured by icon buttons. Compared to selecting from the menu, 
the desired function can be directly executed.
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5) Edit screen

6) Status bar 
The status of the operation and setting is displayed.

5) Edit screen

Scroll Lock status

The instruction of the 
mouse cursor position

CPU 
type

The location of the 
CPU connected

Caps Lock
 status

Num Lock 
status

Current input mode is displayed.

Ladder creating screen, monitor screen and so on are multiply displayed by windows.
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Appendix 1.1.2 About the "Project"

"Project" consists of Program, Comment, Parameter and Device Memory.
An aggregate of a series of data in GX Developer is called "Project", and stored as a folded of 
Windows®.

 ● Editing multiple projects 

Start multiple GX Developer when more than one projects are to be edited.

Project

Program

Comment

Parameter

Device Memory

This is equivalent to the of Windows®.

Sequence program

Comment on the devices

Parameter setting data of PLC

Contents of the current device value, or the input device value

folder
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Appendix 1.2 Starting GX Developer and creating a new project
Appendix 1.2.1 Starting GX Developer

1) Start from the Start  button of Windows®, 
and select in the following order. 
[Programs] 
             ↓ 
[MELSOFT Application] 
             ↓ 
[GX Developer]

2) GX Developer is started.
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1) Select  from the toolbar, or select [Project] 
→ [New project] ( Ctrl  + N ) from the menu.

Appendix 1.2.2 Creating a new project

2) Click the [▼] button of [PLC series].
3) Select "FXCPU".

4) Click the [▼] button of [PLC type].
5) Select "FX3U(C)".
Note: Select the series name that is actually used.

1) Click

1) Click

 3) Click and select

2) Click

 5) Click and select

4) Click
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6) Click OK .

7) New project screen is displayed and the 
project can be input.

6) Click

7) New project screen
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Appendix 1.3 Creating a program
Appendix 1.3.1 Creating a program by using the function keys

[Program to be created]

X002
Y000

Y000

X000

X003
Y001

• The keyboard shortcuts for ladder elements are displayed on the buttons of the toolbar. 
 
                                                                          Main key operations 
 
 
 
 
 
 
 
 

• When creating a program, make sure to set to "Write Mode". 

Select from the toolbar. Select from the menu  ([Edit] → [Write mode]). 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Use half-width characters when inputting. Full-width characters are not allowed.

Point

F5 F6 F7

F8

F9

F5

Shift Shift

F6

Shift

F9

Ctrl

F10

F9

Ctrl
+

++++

In this book, the number of the input 
relay and output relay is displayed 
as "X000", "Y000" by three digits.
"X0", "Y1" and the "0" on the left 
front can be omitted when the input 
is performed from GX Developer.

Point
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1) Press the F5   key. 
Input "X2".

6) The ladder input 
X0

 is displayed.
7) Press the F7   key. 

Input "Y0".
8) Confirm by pressing the Enter  key or [OK].

9) The ladder input  is displayed.
10)  Press the Shift  + F5   key. 

Input "Y0".
11) Confirm by pressing the Enter  key or [OK].

3) The ladder input 
X2

 is displayed.
4) Press the F6   key. 

Input "X0".
5) Confirm by pressing the Enter  key or [OK].

Cancel it by ESC  or [Exit].

2) Confirm by pressing the Enter  key or [OK].

1) Input "X2"   2) Input the Enter  key

4) Input "X0"

3) The ladder element is displayed.

  5) Pressing the  Enter  key

6) The ladder element is displayed.

7) Input "Y0"   8) Pressing the  Enter  key

  11) Pressing the  Enter  key10) Input "Y0"

9) The ladder element is displayed.
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12)   The ladder input 
Y0

 is displayed.
13)    Move the cursor to the beginning of the next 

line.
14)    Press the F5   key. 

Input "X3".
15)  Confirm by pressing the Enter  key or [OK].

16)   The ladder input 
X3

 is displayed.
17)    Press the F7   key. 

Input "Y1".
18)   Confirm by pressing the Enter  key or [OK].

19)    The ladder input  is displayed.  

12) The lader element is displayed

13) Move the cursor

  15) Pressing the  Enter  key14) Input "X3"

17) Input "Y1"   18) Pressing the  Enter  key

16) The lader element is displayed

19) The ladder element is displayed.

F4  (Convert)

20) The gray shade disappears.
20) Convet Operation [Important] 

Perform the "Conversion" operation to finalize 
ladder that not been compiled (the gray part). 
 
 
Press the F4  (Convert) key. 
Or select  from the toolbar, or select 
[Convert] → [Convert] from the menu.

The gray shade disappears and the program 
is confirmed.
If an error occurs, the cuarsor moves to the 
problematic part of the program. Correct the 
program.
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Appendix 1.3.2 Creating a program by using the toolbar buttons

[Program to be created]

• Click the toolbar buttons to input ladder elements. 
 
                                                                              Main toolbar buttons 
 

• When creating a program, make sure to set to "Write Mode". 

Select from the toolbar.       Select from the menu ([Edit] → [Write mode]). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Use half-width characters when inputting. Full-width characters are not allowed.

Point

X002
Y000

Y000

X000

X003
Y001

In this book, the number of the input 
relay and output relay is displayed 
as "X000", "Y000" by three digits.
"X0", "Y1" and the "0" in the left front 
can be omitted when the input is 
performed from GX Developer. 

Point
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6) The ladder input 
X0

 is displayed.
7) Click the tool button . 

Input "Y0".
8) Confirm by pressing the Enter  key or [OK].

9) The ladder input  is displayed.
10)    Click the tool button  . 

Input "Y0".
11)   Confirm by pressing the Enter  key or [OK].

Cancel it by ESC  or [Exit].

3) The ladder input 
X2

 is displayed.
4) Press the tool button  . 

Input "X0".
5) Confirm by pressing the Enter  key or [OK].

2) Confirm by pressing the Enter  key or [OK].

1) Click the tool button . 
Input "X2".

2) Click1) Input "X2"

5) Click4) Input "X0"

3) The ladder element is displayed.

8) Click7) Input “Y0”

6) The ladder element is displayed.

11) Click10) Input “Y0”

9) The ladder element is displayed.
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12)   The ladder input 
Y0

 is displayed.
13)    Move the cursor to the beginning of the next 

line.
14)    Click the tool button . 

Input "X3".
15)   Confirm by pressing the Enter  key or [OK].

16)   The ladder input 
X3

 is displayed.
17)    Click the tool button  . 

Input "Y1".
18)   Confirm by pressing the Enter  key or [OK].

19)    The ladder input  is displayed. 

13) Move the cursor 

12) The ladder element is displayed.

15) Click 14) Input "X3" 

18) Click 17) Input "Y1" 

16) The ladder element is displayed.

19) The ladder element is displayed.

F4  (Convert)

20) The gray shade disappears.

   Convert Operation [Important] 
Perform the "Conversion" operation to 
finalize ladder that not been compiled 
(the gray part). 
  
Press the F4  (Convert) key. 
Or select  from the toolbar, or select 
[Convert] → [Convert] from the menu.

The gray shade disappears and the 
program is compiled.
If an error occurs, the cursor moves to the 
problematic part of the program. Correct the 
program.
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Appendix 1.4 Writing programs to PLC
Write the created sequence program to FX PLC.

Appendix 1.4.1 Connecting PC to PLC

Connecting the personal computer to an FX3G PLC (with a USB cable)

[Preparation on the personal computer side]

For connecting the personal computer to an FX3G PLC with a USB cable, it is necessary to install the 
USB driver software in the personal computer.
Install the USB driver software in accordance with the procedure described in the “GX Developer 
Operating Manual (Startup)”.

Port (USB) 
built in PLC

USB cable

USB

GX Developer

[Connection diagram]
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Appendix 1.4.2 "Transfer Setup" in GX Developer

Configure the settings of GX Developer to communicate with PLC.

1) Select [Online] → [Transfer Setup].
2) Double-click the icon .

3) Set the communication port of personal 
computer side. 
Choose "USB(GOT transparent mode)" for 
connecting to the built-in USB port of the 
FX3G PLC. 

4) Click [OK] after the setting is completed.

5) Click [Connection test], to check 
communication with PLC.

6) After checking, click [OK] to confirm the 
setting configured.

1) Transfer Setup is displayed.

2) Double-click

3) (a)

3) (b)

3) (c)

4) Click

5) Click

6) Click
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Appendix 1.4.3 Writing a program to the PLC

1) Set the "RUN/STOP" switch of PLC to 
"STOP".

3) Click [Param + Prog].
4) Click [Execute].

2)  Select  from the toolbar or select  
[Online] → [Write to PLC] from the menu.

5) Click [OK] after it is completed.

2) Click

4) Click

3) Select the data
    to be written

5) Click

The dialog box of the progressing rate is 
displayed.

1) Set to 
    "STOP"
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Appendix 1.4.4 Monitoring PLC operation

1) Set the "RUN / STOP" switch of PLC to 
"RUN". 

1) Set [Switch X002 is "ON"] and [Switch X000 is "OFF"], and then check [Output Y000 is "ON"].
2) Check [Output Y000 is "ON"] while [Switch X002 is "OFF"].
3) Set [Switch X000 is "ON"] and then check [Output Y000 is "OFF"].
4) Check [Output Y001 is "ON/OFF"] in accordance with [Switch X003 is "ON/OFF"].

 2) Click

2) Select  from the toolbar or select [Online] 
→ [Monitor] → [Monitor mode] from the menu.

1) Set to "RUN"

 Check operation by monitor mode
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(1) The display of the monitor status dialog

4)3)2)1)

(2) Interpretation of the ladder monitor display

Reference

1) Scan time 
The maximum scan time of the sequence 
program is displayed.

2) PLC status 
The status of the PLC is displayed.

3) The execution status of the monitor 
This icon flashing when the monitor is 
being executed.

4) Memory type 
The memory type of the PLC is displayed.

1) Contact Instruction
Input contact

Type X0: OFF X0: ON

NO contact
X000

Contact open

X000

Contact close

NC contact
X000

Contact close

X000

Contact open

2) Out Instruction
Driving status

Type
Non-execution/

Non-drive Execution/Drive

OUT instruction
Y000 Y000

SET instruction, etc. SET M0 SET M0

The ON/OFF status of the device to be rest is displayed by the monitor using RST instruction. 

Device status
Type

When device to be 
reset is OFF

When device to be 
reset is ON

RST instruction
RST M0 RST M0
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Appendix 1.5 Editing a program
Appendix 1.5.1 Correcting a program

• Make sure to set to "Write Mode" when amending the circuit. 
Select from the toolbar.         Select from the menu ([Edit]→[Write mode]). 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Use half-width characters when inputting. Full-width characters are not allowed. 

• Switch between "Ovrwrte" and "Insert" 
  • Set to "Ovrwrte" when correcting and overwriting ladder. 
  • New ladder will be inserted when the "Insert" mode is on.

Point

Switches between
"Ovrwrte" and "Insert"

by pressing the  Insert  key. 
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1) Changing the OUT coils and contacts

[Program to be corrected]

3) Confirm by pressing the Enter  key or [OK].
4) The corrected result is displayed and the 

ladder block is displayed in gray.

1) Double-click the part need to be corrected.

5) Confirm the changes by pressing the F4  
(Convert) key.

X002

Y000

X000

X003
Y001

Y002

Y000

Change to

2) Change "Y001" to "Y002".

1) Double-click

2) Change "Y002"   3) Pressing the  Enter  key

5) F4 (Convert)

4) The corrected result is displayed.
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2) Adding lines

[Program to be corrected]

3) The line reaching the dropped position is 
added.

4) Locate the cursor on the position where the 
OUT coil is to be added to and click  on the 
toolbar.

1) Click  ( F10 ) on the toolbar. 

X002

Y000

X000

X003
Y001

Y000

Y003

Add the vertical/
horizontal lines and
create the OUT coil.

2) Locate the cursor on the upper right of the 
desired vertical line to be added, and then 
drag it until it reaches the desired position, 
and then drop it.

5) Input "Y3".
6) Confirm by pressing the Enter  key or [OK].

1) Click

2) Drag

Locate the cursor on the upper right of the 
beginning of the vertical line to be added.

5) Change "Y3"   6) Pressing the  Enter  key

The line is added

4) The position of the cursor
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8) Confirm the changes by pressing the F4  
(Convert) key 
 
•  Click  on the toolbar again to finish the 

operation.

7) The added ladder is finished and the ladder 
block is displayed in gray.7) The added ladder

     is completed.

8) F4 (Convert)
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3) Deleting lines

[Program where lines are to be deleted]

3) The lines are deleted.
4) Delete the OUT coil by the Delete  key.

1) Click  Alt  + F9  on the toolbar.

X002

Y000

X000

X003
Y001

Delete this
ladder

Y000

Y003

2) Locate the cursor on the upper right of the 
desired vertical line to be deleted, and then 
drag it until it reaches the desired position, 
and then drop it.

1) Click

2) Drag

Locate the cursor on the upper right 
of vertical line to be deleted.

3) Lines are deleted

4) Delete it by the  Delete  key
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5) The deleted ladder block is displayed in gray.

6) Confirm the changes by pressing the F4  
(Convert) key.

• Click  on the toolbar again to finish the 
operation.

6) F4 (Convert)
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Appendix 1.5.2 Inserting and deleting rows

1) Adding rows

[Program where a rung is to be inserted]

3) A row is inserted.

X002

Y000

X000

X003
Y001

Add this rungX001

Y000

Y002

2) Right click the mouse at any place, and select 
[Insert line].

A row is inserted above the row where the cursor 
is located

1) Locate the cursor on the row below the one to 
be inserted.

4) Add ladder in the inserted row.

5) Confirm the changes by pressing the Convert  
(F4) key.

   1) Move the cursor to the row
       below the one to be inserted

Select "Insert line"

2) 
Right click 
the mouse

3) New row is inserted

4) Add ladder
X001

Y002
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2) Deleting rows

[Program where row is to be deleted]

3) The row is deleted

1) Move to the row to be deleted

X002

Y000

X000

X003
Y001

Delete this row

X001

Y000

Y002

2) Right click the mouse at any place, and select 
[Delete line]

The line to be deleted is displayed in gray. 
Confirm it by pressing Convert  (F4).

Point

1) Move the cursor to 
    the row to be deleted

Select "Delete line"

2) 
Right click 
the mouse

3) Row is deleted
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Appendix 1.5.3 Cutting and copying (pasting) ladder

1) Cut

[Program be edited]

1) Move the cursor to the beginning of the ladder 
to be cut.

X002

Y002

X000

X004
Y004

X007

Y002

Y007
Cut this row

2) Drag it until it reaches the desired position, 
and then drop it.

3) Select  from the toolbar or select [Edit] 
→ [Cut] ( Ctrl  + X ) from the menu, and 
execute cut.

4) The selected area is cut 
A gray part remains when a smaller portion of 
the ladder is cut. After amending the ladder, 
confirm the changes by pressing the F4  
(Convert) key. 

The cut and copy area1) Move the cursor to 
    the beginning of the 
    cut area

2) Drag it until it reaches the desired 
    position, and then drop it

3) Execute cut

4) The selected 
    area is cut
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1) Move the cursor to the beginning of ladder to 
be copied.

2) Drag it until it reaches the desired position, 
and then drop it.

3) Select  from the toolbar or select [Edit] → 
[Copy] ( Ctrl  + C ) from the menu.

5) Select  from the toolbar or select [Edit] → 
[Paste] ( Ctrl  + V ) from the menu.

 
A gray part remains when a smaller portion of the 
ladder is pasted. After amending the ladder, confirm the 
changes by pressing the F4 (Convert) key.

4) Move the cursor to the position where to 
paste.

Switch by the Insert  key
"Ovrwrte" mode : Pastes by overwriting
data from the cursor position.
"Insert" mode : Pastes it by inserting 
data at the cursor position.

Point

2) Copy(Pasting)

1) Move the cursor to the
    beginning of the copy area

3) Execute
    copy

2) Drag it until it reaches the desired 
    position, and then drop it.

4) Move the cursor to the
    position where to paste

5) Finish copy/paste

Y000

X004

X000

X002
Y000

X002
Y000

Y000

X000

Y004

Copy this
row

Paste it to
this row
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Appendix 1.6 Saving the program
Appendix 1.6.1 Save as and save

If there is ladder that has not been compiled, press Convert  (F4).

Point

1) Select  from the toolbar or select [Project] 
→ [Save] ( Ctrl  + S ) from the menu.

6) Click Yes  in the conformation dialog to 
finish.

 
If there is not sufficient space in the floppy disk to save 
the project, temporarily save it to the hard disk and 
then move it to the other floppy disk.

2) Specify the storage destination for the project.
3) Specify the project name.
4) Specify the title describing the project 

(optional).
5) Click Save .

Reference

1) Click

3) Specify the project name

2) Specify the storage 
destination for the project

5) Click

4) Specify the title (optional)

6) Click

(When it is newly saved)

(When it is saved by overwriting)

Project saving is finished. 

• The following characters cannot be used in the project name. 
/ ,\ ,> ,< ,* ,? ,” ,“ , | , : , ; ( ; , \ are only used to specify the driver) 
Also, do not use “.” (period) at the end of the project name.

• When the project name is specified with 8 or more characters by GX Developer (later than SW6D5-
GPPW), characters past the 8th character will not be displayed if read by the old versions (older than 
SW2D5-GPPW) of GX Developer.

• The project path plus its name is within 150 half-width characters (75 full-width characters). 

• The tile is within 32 half-width characters (16 full-width characters).

• If there are spaces in the project path and project name, GX Developer cannot start normally even if 
GPPW.gpj, ***.gps is double-clicked in the Explorer window. 
If there are spaces in the project path and project name, open the project by starting GX Developer → 
selecting [Project] → [Open project] from the menu.
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If there is ladder that has not been compiled, press Convert  (F4).

Point

Appendix 1.6.2 Saving the project as a new one

1) Select [Project] → [Save as] from the menu.

2) Specify the storage destination for the project.
3) Specify the project name.
4) Specify the title describing the project 

(optional).
5) Click Save .

6) Click Yes  in the confirmation dialog and 
finish.

For the way to name the driver/path and the project, 
see the previous page.
 
If there is not sufficient space in the floppy disk to save 
the project, temporarily save it to the hard disk and 
then move it to the other floppy disk.

1) Click

3) Specify the project name

2) Specify the storage 
destination for the project

5) Click

4) Specify the title (optional)

6) Click
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Appendix 1.6.3 Reading the project

1) Select  from the toolbar or select [Project] 
→ [Open project] ( Ctrl  + O ) from the menu.

If another project is open when reading/opening a new file, the current project is closed.
If there is uncompiled ladder in the project or the project is not saved, a warning message is
displayed.

Reference

2) Select the storage destination of the project.
3) Select the project to be read.
4) Click Open  and read the project.

1) Click

3) Select the project to be read.

4) Click

2) Select the storage 
destination of the project.



129

Appendix 1.7 Necessary operation for the debugging program
For connecting to the PLC and the writing a program to the PLC, see "Appendix 1.4 Writing programs to PLC".

Appendix 1.7.1 Ladder monitor
Display the ladder, and monitor the conduction status of the contacts and the driving status of the coils.

2) The ON/OFF status of the ladder and the 
current value of word devices (timer, counter 
and data register) are displayed in the ladder 
monitor window.

3) Right click the window, select [Stop monitor] 
to quit the ladder monitor.

4) In order to correct and write the program, 
select  from the toolbar or select [Edit] → 
[Write mode] from the menu.

1) Select  from the toolbar or select [Online] 
→ [Monitor] → [Monitor mode] from the menu.
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(1) the display of the monitor status dialog

4)3)2)1)

(2) Interpretation of the ladder monitor display

Reference

1) Scan time 
The maximum scan time of the sequence 
program is displayed.

2) PLC status 
The status of the PLC is displayed.

3) The execution status of the monitor 
This icon flashing when the monitor is 
being executed.

4) Memory type 
The memory type of the PLC is displayed.

1) Contact Instruction
Input contact

Type X0: OFF X0: ON

NO contact
X000

Contact open

X000

Contact close

NC contact
X000

Contact close

X000

Contact open

2) Out Instruction
Driving status

Type
Non-execution/

Non-drive Execution/Drive

OUT instruction
Y000 Y000

SET instruction, etc.
SET M0 SET M0

The ON/OFF status of the device to be reset is displayed by the monitor using RST instruction. 

Device status
Type

When device to be 
reset is OFF

When device to be 
reset is ON

RST instruction
RST M0 RST M0
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Appendix 1.7.2 Device registration monitor

1) Registering optional devices
Register the optional devices in the monitor window and monitor the necessary part only.

4) Input the device number to be registered in 
the Register device window. 

5) Click [Register].

6) The device is registered in the monitor 
window. 

7) Click [Start monitor], and the value showing 
the device action and the ON/OFF status of 
the contacts and coils are displayed.

1) Set the ladder monitor status. (See Section 
Appendix 1.7.1) 

2) Select [Online] → [Monitor] → [Entry data 
monitor] from the menu. Or right click 
the ladder window and select [Entry data 
monitor]. 

3) Click

Select "32 bit integer" 
when you want to 
nomitorthe device in 
32 bits. 

4) Input the device

5) Click

7) Click

3) Click [Register devices] in the "Entry data 
monitor" window.
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1) Set to monitor mode. (See Section to 
Appendix 1.7.1) 

2) Select [Online] → [Monitor] → [Entry data 
monitor] from the menu. Or right click the 
ladder monitor window and select [Entry data 
monitor]. (See the previous page) 

3) Select [Window] → [Tile horizontally] from the 
menu to display the "Ladder monitor window" 
and "Entry data monitor window" apposed 
together. (Set "Entry data monitor window" to 
the status of stop monitoring). 

4) The "Ladder monitor window" and "Entry data 
monitor window" are displayed horizontally.

2) Registering the devices displayed in the ladder monitor
Specify the area of the ladder in the ladder monitor window and register all of the devices in the area.

5) Click the start point of the ladder.

6) Click the end point while pressing
    [Shift] key to select the area.

7) Drag

8) The devices are registered to the monitor 
window. 

9) Click [Start monitor], and the value showing 
the device action and the ON/OFF status of 
the contacts and coils are displayed.

9) Click

5) Click the start point of the ladder. 

6) Click the end point while pressing the [Shift] 
key to select the area. 

7) Drag the selected area to the "Entry data 
monitor window".
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Appendix 1.7.3 Device batch monitor
Specify a device and monitor a continuous range of devices that follow it.

1) Set to monitor mode. (See Section Appendix 
1.7.1) 

2) Select [Online] → [Monitor] → [Device batch] 
from the menu. Or right click the ladder 
window and select [Device batch].

3) Input the device

4) The value showing the device action and the 
ON/OFF status of the contacts and coils are 
displayed.

3) Input the first device of the devices to be 
monitored in the "Device batch monitor" 
window and then pressing the Enter  key, and 
then click [Start monitor].
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Appendix 1.7.4 Device test

1) Force ON/OFF
Forcedly turn ON/OFF the bit devices of PLC (M, Y, T, C and so on). (The forced ON/OFF function of X 
is not available).
When PLC is running, the forced ON/OFF function can turn on or off the devices only for one scan and 
the operations according to the sequence program are given priority.  When checking the output, set 
PLC to the STOP status.

1) Set to monitor mode. (See Section Appendix 
1.7.1) 

2) Select [Online] → [Debug] → [Device test] 
from the menu. Or right click the ladder 
window and select [Device test].

Forced ON/OFF (Ladder monitor window)
Any bit device (contact and coil) can be forcibly turned on/off by double-clicking the device in the 
[Ladder monitor window] while pressing the [Shift] key.

Reference

3) Input the device

4) Click

3) Input the device number to be forcibly turned 
on/off. 

4) • [FORCE ON]: Forces device to ON. 
• [FORCE OFF]: Forces device to OFF. 
•  [Toggle force]: Forces the device to toggle 

ON/FF each time it is pressed.
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2) Changing the current value of the word device
Change the current value of the PLC’s word device (T, C, D and so on).

1) Set to monitor mode. (See Section Appendix 
1.7.1.) 

2) Select [Online] → [Debug] → [Device test] 
from the menu. Or right click the ladder 

3) Input the device

5) Click   4) New value

window and select [Device test].
3) Input the device number to be changed. 

4) Input a new value. 

5) Click [Set].
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Appendix 1.7.5 Writing a program to the PLC during RUN
Write the corrected part of the ladder to the PLC when the PLC is running.
Less time is needed for writing during RUN since the entire program is not transferred.

1) A contact will be added to the ladder on the 
left as an example. Within the ladder view, set 
the mode to write mode (  ).

It is impossible to write the program to the PLC if the program in the PLC is different from the one in 
GX Developer. Verify in advance, or transfer the program first by using [Write to PLC]. 

Caution

2) Add the contact. 
The ladder block is displayed in gray.

3) Press [Shift] and [F4] together, or select 
[Convert] → [Convert (Write during RUN)] 
from the menu.

5) The message "RUN write processing has 
completed." is displayed. Click [OK].

2) Add the contact

4) Click

5) Click

Write during RUN  [Shift]+[F4]

4) Click [Yes] to confirm the warning message 
about PLC safety regarding online changes.
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Appendix 1.8 Inputting comment
Appendix 1.8.1 Types of the comment
The following 3 types of the comments can be input.

Type Purpose
The number of 
characters 
(full-width)

Remark

1) Device comment A comment describing the role 
and function of each device 16

It is necessary to set the "Comments 
capacity" in the parameter setting when 
writing to the PLC. The "Comment 
range setting" must also be set.

2) Statement A comment describing the role 
and function of ladder blocks 32

This is a comment on GX Developer 
side. 
(It is not downloaded to the PLC).

3) Note A comment describing the role 
and function of output instructions 16

This is a comment on GX Developer 
side. 
(It is not downloaded to the PLC).

[Comment Examples]

How to display the comment
• Select [Display] → [Display comment] from the menu and then the comments are displayed.

• Repeat the operation above to stop displaying comments.

Point

T5 NO contact exists at step10,
whereas T5 NC contact exists at step8.

3) Note

2) Statement

1) Comment

X000

Y000

Y000

T5

T7

Start

Lamp
Green

Conveyor
Stop
Time

START Circuit

Buzzer Time Setting

Lamp Green

2-second Timer

0

4

8

<The Start Btn truns on lamp   >

<Buzzer rings awhile                 >

(Y000   )
Y000
A/S
A/S

1

T5
B/D
B/D

10
8

4
Lamp
Green

K20

(Y001   )
Buzzer

T5
2-second 
Timer
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Appendix 1.8.2 Operation for creating device comments

1) How to input device comments using a list

1) Double click [Device comment] → 
[COMMENT] in the project list.

1) Click

2) Input the start device of the devices to be 
commented in "Device name", and click 
[Display]. 

3) Input comments in the "Comment" column. 
 
•  When inputting comments for another 

device, Input the device number again in 
step 2.

2) Input the device number

3) Input comments

1) Click  from the toolbar and double-click the 
ladder element to be commented. 

2) Input the comment in the "Enter symbol" 
window and click [OK]. 
 
•  Click  on the toolbar again to finish the 

operation. 

2) How to input the device comments in the ladder

1) Double-click

2) Input the comment
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Point

Reference

Setting for writing the device comments to the PLC
It is necessary to set "Parameter setting" and "Comment range setting" in order to write the device 
comments to the PLC.

1) Parameter setting
• Select [Parameter] → [PLC parameter] in the project list.

• Set the "number of blocks" in the "Comments capacity" setting. 
One block is equivalent to 50 comments, occupying 500-steps of program memory.

Comment capacity setting

The capacity of the program 
decreases as more comment 
blocks are added.

2) Comment range setting
• Select [Device comment] → [Comment], and then the comment input screen is displayed.

• Select [Edit] → [Setup comment range] from the menu.

• Set the type and the range of the devices to be written to PLC in the Setup comment rang dialog.

Comment 
range setting

Continues during command write

Select [Tool] → [Options] from the menu, Check 
"Continues during command write" of the 
[Comment input] box in the [Program common] 
tab.
After configuring the settings as above, the 
operation of the ladder input continues and the 
"Enter symbol" window described in step 2) is 
displayed, when the program is being created.
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Appendix 1.8.3 Operation for creating statements

1) Click  from the toolbar, and double-click 
anywhere on the ladder block where the 
statement is to be written. 

2) Input the statement in the "Enter line 
statements" window and click [OK]. 
 
•  Click  on the toolbar again to finish the 

operation.

Appendix 1.8.4 Operation for creating notes
1) Click  from the toolbar, and double-click 

the output instruction symbol where the note 
is to be written. 

2) Input the note in the "Enter Note" window and 
click [OK]. 
 
•  Click  on the toolbar again to finish the 

operation.

1) Double-click

2) Input the statement

2) Input the note

1) Double-click
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Appendix 1.9 Operation for creating the program list
In GX Developer, the program can also be created by list.

Appendix 1.9.1 Displaying the list edit screen

1) Create a new project (See Section Appendix 
1.2.2) or display the ladder of the existing 
project. 

2) Select  from the toolbar or select [View] → 

Appendix 1.9.2 How to input instructions

1) Input the instruction language from step 0 
sequentially. 
The step number is added automatically when 
instruction is input. (For the input procedures, 
see the next page).

1) The list edit screen is displayed.

3) The list edit screen
     is displayed.

Initial screen           After list input

[Instruction list] from the menu.
3) The list edit screen is displayed. 

Click  on the toolbar again or select [View] 
→ [Ladder] from the menu to return to the 
ladder display.
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[Examples for the basic instructions]
LD 
OUT
LDI
AND
OUT
LD
OUT
OUT

[Examples for the applied instructions]
MOV
CMP

X0 Enter

Y0 Enter

X0 Enter

Y0 Enter

M0 Enter

M0 Enter

T0    K10 Enter

C0    K5 Enter

K1    D0   Enter

K20  D3  M10 Enter

 ● How to input the basic instructions and the applied instructions
A "space" is input between the instruction language, device number and operand.

Connection and OUT instructions

The key operation when inputting/editing
 • "Ovrwrte"/"Insert" mode switches by pressing the Insert  key.

 • An instruction can be deleted by the Delete  key.

 • [Insert line] and [Delete line] operations can be done by the right click of the mouse

Reference

Coil instructions for the timer and counter
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Appendix 1.9.3 Checking the content of the list input
Confirm that there are no errors in the program created by list input in the ladder display.

1) Select  from the toolbar, or select 
 [View] → [Ladder] from the menu.

2) Check whether the program created by list 
input is displayed.

3) Select [Tools] → [Check program] to execute 
the program check, and check whether errors 
occur and the error steps.
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MEMO
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Appendix 2
Introduction example list programs
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Introduction example 1
List program: Example 1

List program: Example 2

List program

List programList program

Step Command
0 LD X001
1 OR Y000
2 ANI X003
3 OUT Y000
4 OUT Y003
5 END

Step Command
0 LD X001
1 SET Y000
2 SET Y003
3 LD X003
4 RST Y000
5 RST Y003
6 END

Step Command
0 LD X000
1 AND X001
2 OUT Y001
3 LD X003
4 OR Y003
5 ANI X004
6 OUT Y003
7 LD Y003
8 OUT C0 K5
11 LD C0
12 OUT Y000
13 LD X002
14 RST C0
16 END

Introduction example 2

Introduction example 3

Step Command
0 LD X001
1 OR Y003
2 ANI C0
3 OUT Y003
4 LD X004
5 OUT C0 K4
8 LD C0
9 OUT Y001
10 OUT T0 K10
13 AND T0
14 OUT Y002
15 OUT T1 K20
18 LD T1
19 RST C0
21 END

Introduction example 4

Step Command
0 LD X001
1 OR Y000
2 ANI X003
3 OUT Y000
4 LD Y000
5 AND X000
6 OUT Y002
7 AND Y002
8 MPS
9 AND X005
10 ANI Y003
11 OUT Y001
12 MPP
13 AND X006
14 ANI Y001
15 OUT Y003
16 END

Appendix 2.1 List programs 
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List program
Introduction example 5

Step Command
0 LD X001
1 OR Y000
2 ANI T4
3 OUT Y000
4 OUT T0 K20
7 LD T0
8 OUT Y001
9 OUT T1 K20
12 LD T1
13 OUT Y002
14 OUT T2 K20
17 LD T2
18 OUT Y003
19 OUT T3 K20
22 LD T3
23 OUT Y004
24 OUT T4 K20
27 END
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By using the handy programming panel (HPP) …
You can easily edit programs in list format using the HPP.
For creating programs and debugging equipment on sites where personal computers cannot 
be always installed, the HPP is convenient to give simple modifications to programs and 
changing constants of timers and counters. 

For checking the contents of errors …
You can easily check the contents of errors using the monitor function and program check 
function of the HPP.

For storing programs and transferring programs to PLCs …
The HPP FX-30P can store up to 15 sequence programs (or up to 7 sequence programs if 
their capacity exceeds 32000 steps).  The personal computer is not required to update PLCs 
far way from the personal computer.

For export equipment …
Because the HPP FX-30P offers display in Japanese, English and Chinese, it can be included 
with export machines.

Appendix 3
Handy Programming Panel              
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PLC

Handy programming panel 
FX-30P main unit

Program cable 
FX-20P-CAB0
 (1.5 m)

Programming port

You can easily edit programs in list format using the HPP FX-30P.
For creating programs and debugging equipment on sites where personal computers cannot be always 
installed, the HPP is convenient for making simple modifications to programs and changing constants 
of timers and counters.

1) Functions convenient for setting up equipment
• Editing programs using instruction list
• Monitoring and forcing ON/OFF of devices

2) Functions convenient for troubleshooting
• Program check function
• PLC diagnosis function

3) Functions convenient for maintenance
• Change of timer set values and counter set values
• Transfer of updated sequence programs 
(The HPP can store up to 15 sequence programs whose capacity is 32000 steps or less).

4) Functions convenient for export equipment
• Operation messages can be switched between English, simplified Chinese and Japanese.

[Example of connection] [FX-30P  Dimensions]

87mm

17
0m

m

Mass : 0.3kg

Appendix 3.1 Handy programming panel (HPP)
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[FX-30P Function List]
 ■ Online mode (Functions to directly access the memory inside the PLC)

Function Description

Programming

Read
Reads a sequence program (from the program memory inside the PLC to the 
screen on the FX-30P).

Write
Writes a sequence program (by key inputs in the FX-30P to the program memory 
inside the PLC).

Insert
Inserts instructions into a sequence program (by key inputs in the FX-30P into the 
program memory inside the PLC).

Delete
Deletes instructions from a sequence program (by key inputs in the FX-30P from 
the program memory inside the PLC).

Monitor Reads the operation state (from the memory inside the PLC to the screen on the FX-30P).
Test Forcibly writes devices (by key inputs in the FX-30P to the memory inside the PLC).

Others

Offline select Switches to offline mode.
PLC diagnosis Diagnoses the PLC.
Memory cassette transfer Transfers data to the memory cassette.
Parameter Sets parameters.
Keyword Sets keywords.
Device conversion Executes device conversion.
Latch clear Executes latch clear.
Device batch monitor Executes device batch monitor.
BFM batch monitor Executes buffer memory batch monitor.
Baud rate Changes the baud rate.
PLC memory clear Clears the memory inside the PLC.
Remote RUN/STOP Changes over the PLC state between “RUN” and “STOP”.
PLC clock setting Sets the clock in the PLC.
HPP setting Sets the HPP

 ■ Offline mode (Functions to access the RAM memory inside the FX-30P)
Function Description

Programming

Read Reads a sequence program (from the RAM built in the FX-30P to the screen on the FX-30P).
Write Writes a sequence program (by key inputs in the FX-30P to the RAM built in the FX-30P).

Insert
Inserts instructions into a sequence program (by key inputs in the FX-30P into the 
RAM built in the FX-30P).

Delete
Deletes instructions from a sequence program (by key inputs in the FX-30P from 
the RAM built in the FX-30P).

Others

Online select Switches to online mode.
Program check Checks programs.
HPP-FX transfer Transfers data between the RAM built in the FX-30P and the FX PLC.
HPP-PC transfer* Transfers data between the RAM built in the FX-30P and the personal computer.
Parameter Sets parameters.
Device conversion Executes device conversion.
PLC type Changes the PLC type.
HPP memory clear Clears the memory inside the FX-30P.
Program management Manages programs stored in the RAM and flash memory (15 blocks) built in the FX-30P.
HPP setting Sets the HPP.

*: The firmware Ver. 1.10 or later supports transfer between the HPP and the personal computer.

 ■ HPP setting (Setting functions for the FX-30P main unit)
Function Description

Language Selects display language(English, Japanese and Chinese).
Buzzer sound volume Adjusts the buzzer sound volume.
LCD contrast Adjusts the LCD contrast.
Backlight brightness Adjusts the backlight brightness.
Screen saver Sets the screen saver.
HPP protect Sets protection to programs stored in the FX-30P.
HPP initialization Returns the FX-30P to factory default settings.
HPP F/W update Updates the firmware stored in the FX-30P.

[FX-30P  Dimensions]
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Appendix 4
Training Machine Wiring
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L

N

X000

X001

X002

X003

X004

X005

X006

Y004

Y003

Y002

Y001

Y000

0 V

S/S 24 V

COM0
to

COM2

Power supply
100 V AC

Breaker
Micro PLC

FX3G-14MR/ES

Lamp (red)

Variable resistor
Low   High

Buzzer

Magnetic contactor

Relay

Solenoid valve

Select switch

Proximity switch

Limit switch

Toggle switch

Pushbutton switch

Pushbutton switch

Contact
Motor

FX-I/O-DEMO2 Type Training Machine

 A

A 

Appendix 4.1 I/O Wiring Diagram for Training Machine
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Date Revision Description

4/2006 A     First Edition

3/2007 B Adding and revising the other descriptions.

2/2014 C Adding and revising the other descriptions.

9/2014 D Adding and revising the other descriptions.

5/2015 E A part of the cover design is changed.

Revised History
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